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Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

A\DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

A wArRNING

indicates that death or severe personal injury may result if proper precautions are not taken.

A cauTion
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific
task in accordance with the relevant documentation, in particular its warning notices and safety instructions.
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

A WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the

information in this publication is reviewed regularly and any necessary corrections are included in subsequent
editions.

Siemens AG A5E39439812-05-76 Copyright © Siemens AG 2021.
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Warranty and liability 1

Note

The application examples are not binding and do not claim to be complete with regard to
configuration, equipment or any contingencies. The application examples do not represent
customer-specific solutions. They are only intended to provide support for typical
applications, you are responsible for the correct operation of the described products. These
application examples do not relieve you from responsibilities of using, installing, operating
and servicing the equipment safely and professionally. When using these application
examples, you recognize that we are not liable for any damagel/claims beyond the liability
clauses described.

We reserve the right to make changes to these application examples at any time and without
prior notice. If there are any deviations in the recommendations provided in this application
example and other Siemens publications, for example catalogs, the contents of the other
documents shall have priority.

We do not accept any liability for the information contained in this document. Any claims
against us — based on whatever legal reason — resulting from the use of the examples,
information, programs, engineering and performance data etc., described in this application
example shall be excluded. Such an exclusion shall not apply in the case of mandatory
liability, for example under the German Product Liability Act ("Produkthaftungsgesetz”), in
case of intent, gross negligence, or injury of life, body or health, guarantee for the quality of
a product, fraudulent concealment of a deficiency or breach of fundamental contractual
obligations ("wesentliche Vertragspflichten").

The compensation for damages due to a breach of a fundamental contractual obligation is,
however, limited to the foreseeable damage, typical for the type of contract, except in the
event of intent or gross negligence or injury to life, body or health. The above provisions do
not imply a change of the burden of proof to your detriment. Any form of duplication or
distribution of these application examples or excerpts hereof is prohibited without the
expressed consent of Siemens AG.

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
Function Manual, 11.2021, A5E39439812-05-76 5



Warranty and liability

1.1 Security information

1.1

Security information

Siemens provides products and solutions with industrial security functions that support the
secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is
necessary to implement — and continuously maintain — a holistic, state-of-the-art industrial
security concept. Siemens’ products and solutions constitute one element of such a concept.

Customers are responsible for preventing unauthorized access to their plants, systems,
machines and networks. Such systems, machines and components should only be connected
to an enterprise network or the internet if and to the extent such a connection is necessary
and only when appropriate security measures (e.g. firewalls and/or network segmentation)
are in place.

For additional information on industrial security measures that may be implemented, please
visit

https:/lwww.siemens.com/industrialsecurity.

Siemens’ products and solutions undergo continuous development to make them more
secure. Siemens strongly recommends that product updates are applied as soon as they are
available and that the latest product versions are used. Use of product versions that are no
longer supported, and failure to apply the latest updates may increase customer’s exposure to
cyber threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS
Feed under
https:/lwww.siemens.com/industrialsecurity.

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
Function Manual, 11.2021, A5E39439812-05-76



Preface 2

Purpose of this document

This document describes LUPS1600 Block Library for SIMATIC STEP 7 V5.6, STEP 7
Professional V16, STEP 7 Professional V17, WinCC Flexible, WinCC V7.4, WinCC V7.5, WinCC
Comfort/Advanced V16, WinCC Comfort/Advanced V17, WinCC Professional V16 and WinCC
Professional V17. The block library provides tested code with clearly defined interfaces. You
can use it as the basis for the task you wish to realize.

The main focus of this document is to describe:
* All Function Blocks (FB) pertaining to the block library.
* The functionality implemented through these blocks.

The documentation furthermore illustrates the possible operating conditions and applications
of the block library for SIMATIC STEP 7 V5.6, STEP 7 Professional V16, STEP 7 Professional
V17, WinCC Flexible, WinCC V7.4, WinCC V7.5, WinCC Comfort/Advanced V16, WinCC
Comfort/Advanced V17, WinCC Professional V16 and WinCC Professional V17.

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
Function Manual, 11.2021, A5E39439812-05-76 7
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References

For more information on SITOP UPS1600 manuals and related documentation, refer the
following links:

Siemens Industry Online Support (https://support.industry.siemens.com/cs/start?lc=en-US)

SITOP UPS1600 Manual (https://support.industry.siemens.com/cs/ww/en/view/84977415)

SIMATIC STEP 7 Basic/Professional V16 and SIMATIC WinCC V16 System Manual
(https://support.industry.siemens.com/cs/ww/en/view/109773506)

SIMATIC Programming with SIMATIC STEP 7 V5.5
(https://support.industry.siemens.com/cs/ww/en/view/45531107)

WinCC flexible 2008 System Manual
(https://support.industry.siemens.com/cs/ww/en/view/18796010)

WinCC 7.4 System Manual
(https://lsupport.industry.siemens.com/cs/ww/en/view/109736220)

WinCC 7.5 System Manual
(https:/lsupport.industry.siemens.com/cs/ww/en/view/109760739)

GSD for SITOP UPS1600 for integration into SIMATIC STEP 7 V5.6
(https://support.industry.siemens.com/cs/ww/en/view/75854605)

Support Packages for the hardware catalog in the TIA Portal (HSP)
(https://support.industry.siemens.com/cs/ww/en/view/72341852)
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Task

Overview of the automation task

The figure below provides an overview of the automation task:

L
N &-
PE T
Power Supply
% i -
24V, unbuffered _ 2 T
[
ups Non-critical process devices
24V, buffered * L
’/),6\ T
@+ /;);
NP
6?990/)
HMI
PLC
Automation [ |
network [
Other critical process devices
Legend

. L: Phase
. N: Neutral

. PE: Protective earth/ground

B Profinet

Figure 3-1
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Task

Task Description

10

Your task is to equip the automation plant with Uninterruptible Power Supply (UPS). In the
event of a power failure, critical process participants are to be protected.

In the event of a power failure of the automation plant, process values are to be maintained
and plant components be safeguarded against mechanical damage by means of a defined
stopping process.

UPS is integrated into the automation network via PROFINET.

The status and diagnostic information of the UPS is displayed in the individual Human
Machine Interfaces (HMI) stations.

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
Function Manual, 11.2021, A5E39439812-05-76



Structure

4.1 Solution overview

Structure
The figure below shows a schematic overview of the most important components of the
solution:

24V, unbuffered * 1 | JI.
4
= Non-critical process devices
24V, buffered * i
CPU Comfort
=] Panel
S7-1214
TP1200
PROFINET
Other critical process devices
Legend

. L: Phase
. N: Neutral

. PE: Protective earth/ground

Figure 4-1
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Structure

4.1 Solution overview

Scope of this application example

This application example provides FB1 function block for communication between the
controller and SITOP UPS1600.

It also provides faceplates and screen windows for monitoring and operation.

Note
SITOP UPS1600 is termed as UPS1600 throughout this document.

Function of the hardware components

Advantages

Scope

12

The table below describes the function of the Hardware (HW) components used in figure 4-1:

Name Function
SITOP Power Supply Central 24 V power supply for all process devices.
Non-critical process devices Symbol for other non-critical process devices. (Devices that can

be switched off when there is sufficient pressure, for example:
compressors.)

SITOP UPS1600 and SITOP UPS1100 | UPS with buffer (example, battery module).

S7-1214 Automation controller

Comfort Panel TP1200 Control panel for process visualization.

Other critical process devices Symbol for other critical process devices.
PROFINET Central process bus of all automation devices.

This application offers the following advantages:
* Time and cost saving by means of FB1, HMI faceplates and screen windows.

* Easy and comprehensive introduction to integrating UPS1600 within a PROFINET network.

This application does not include description of:

* Creating program blocks in SIMATIC STEP 7 V5.6/STEP 7 Professional V16.
* Creating screens and objects in WinCC flexible/WinCC TIA Portal/WinCC.

* Configuring communication between the described terminal devices.

¢ Handling all the described SIMATIC terminal devices.

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
Function Manual, 11.2021, A5E39439812-05-76




Structure

4.1 Solution overview

Assumed knowledge

The user is assumed to have knowledge on the mentioned points:

Using SIMATIC STEP 7 V5.6, STEP 7 Professional V16, STEP 7 Professional V17, WinCC
flexible, WinCC V7.4, WinCC V7.5, WinCC Flexible 2008 SP5, WinCC Comfort/Advanced
V16, WinCC Comfort/Advanced V17, and WinCC TIA Portal.

Operating, handling, and configuring SIMATIC S7 controllers (57-300/400 and S7-
1200/1500).

Operating, handling, and configuring HMI control panels (Multi Panels, Comfort Panels)
and Runtime systems (WinCC flexible Runtime, WinCC Runtime Advanced, WinCC
Runtime, WinCC Runtime Professional).

Handling and operating SITOP UPS1600.

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
Function Manual, 11.2021, A5E39439812-05-76 13



Structure

4.2 Description of the core functionality

4.2 Description of the core functionality

Sequence of the core functionality

Communication between UPS1600 and controller runs via PROFINET. The UPS1600 is
connected to the controller as PROFINET 10 node. Thus, the entire UPS1600 information
(voltage, power, possible buffer time, battery state) is available in the controller.

In this application example, two scenarios are realized.

e The Programmable Logic Controller (PLC) via the supplied program block FB1 recognizes
power failure. The information is made permanently available in the control program
which can be then evaluated. This allows your process to respond and switch off your
process devices in a defined manner.

e The Programmable Logic Controller (PLC) via the supplied program block FB2 recognizes
diagnostic interrupts and generates alarm messages to WinCC.

e With the provided faceplates and screen windows, relevant information and important
parameters are displayed on the HMI control panel.

Note
FB2 is applicable only to SIMATIC STEP7 V5.6.

Overview and description of the user interface
The application example provides the following views in the faceplate:
e UPS state
* General Device information
e OQOutput Data
* Voltage and power trend curves

* Currently pending alarms/alarm history

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
14 Function Manual, 11.2021, A5E39439812-05-76



Structure

4.3

Hardware components

4.3 Hardware and software components used

Hardware and software components used

Component

No.

Article number

Note

SITOP UPS1600 20 A

6EP4136-3AB00-2AY0

Alternatively,

SITOP UPS1600 10 A
6EP4134-3AB00-2AYO0 or
SITOP UPS1600 40 A

6EP4137-3AB00-2AYO0 is
used.

MP277 8" Touch

6AV6643-0CBO1-1AX5

Refer to Requirements
(Page 77).

Comfort Panel TP900

6AV2124-0JC0O1-0AX0

Refer to Requirements
(Page 98).

CPU 1214C DC/DCIRLY PN/DP

6ES7214-1HG40-0XBO

Or other
S7-1200/1500 CPU

CPU 315-2 PN/DP

6ES7315-2EH14-0AB0O

Or other S7-300 CPU

SITOP UPS1100 3.2 Ah (Battery
module)

—_

6EP4133-0GB0O0-0AYO

Note

The UPS1600 is upgraded with Firmware (FW) version 2.4 or higher.

Standard software components

Component

No.

Article number

Note

WinCC Flexible 2008 SP5 Advanced

6AV6613-0AA51-3CAS

Alternatively, WinCC
flexible 2008 SP5
Standard

WinCC Advanced V16

6AV2102-4AA03-0AE5

Alternatively, WinCC
Comfort V16

STEP 7 Professional V5.6

6ES7810-4CC10-0YAS

STEP 7 Professional V16

6ES7822-1AA03-2YA6

WinCC Professional V16

6AV2103-0DA03-0AA5

WinCCV7.4

R\, [N JUIEN JNIRN

6AV6381-2BD07-3AH0O

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7

Function Manual, 11.2021, A5E39439812-05-76
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Structure
4.3 Hardware and software components used

Library contents

The following table contains the library contents that are used in this example:

Component Note

LUPS1600 This folder contains the library for TIA Portal V16 and
master copies for STEP 7 V16 and WinCC V16.

SITOP-UPS1600_Library STEP7-V5_V3- This folder contains the following subfolders:

1.72 e UPS1600 V3-0 STEP7 V5.6
* UPS1600 V3-0 library WinCC flexible 2008
* UPS1600 V3-0 library WinCC V7.4
* UPS1600 V3-0 library WinCC V7.5

UPS1600 V3-1 STEP7 V5.6 This folder contains the library of the function blocks (FB)
for SIMATIC STEP 7 V5.6.

UPS1600 V3-1 library WinCC flexible This folder contains the library of the faceplates for WinCC

2008 flexible 2008 SP5.

UPS1600 V3-1 library WinCC V7.4 This folder contains the library of the screen windows for
WinCCV7.4.

UPS1600 V3-1 library WinCC V7.5 Tins folder contains the library of the screen windows for
WinCCV7.5.

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
16 Function Manual, 11.2021, A5E39439812-05-76



Function blocks 5

5.1 Function and task of the function blocks

Overview

This chapter describes the application and requirements of FB1 and FB2 and its integration
into a SIMATIC STEP 7 project.

Task description and application

* In the event of a plant power failure, it is essential to safeguard certain machine
components against damage and to back-up process relevant data in order to prevent
data loss. The application of FB1 provides the option to bring your plant into a safe state
and switch it off in a program-controlled manner while UPS1600 buffers the voltage.

* The Programmable Logic Controller (PLC) via the supplied program block FB2 recognizes
diagnostic interrupts and generates alarm messages to WinCC.

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
Function Manual, 11.2021, A5E39439812-05-76
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Function blocks
5.1 Function and task of the function blocks

FB1 Function description

The FB1 cyclically monitors the operating mode of the UPS1600. When UPS1600 is in buffer
mode, a 10 s timer within the FB starts. This timer prevents the plant from being brought into
a safe state in the event of just a short voltage dip/drop. If the UPS is still in buffer mode after
expiry of the timer, the parameter UPSReadyForReset is set from FALSE to TRUE. Further,
this parameter is also used to bring the plant components into a safe state (maintenance
mode). When the plant is brought into a safe state, the parameter UPSExecuteReset is set
from FALSE to TRUE. The FB1 then sends a command to the UPS1600, which then switches
off autonomously. The following flow diagram displays the program sequence of the FB1.

Buffer mode
UPS1600
N

y
Timer )

y

A
i Output UPSReadyForReset is set

y

User Program

A 4

i Input UPSExecuteReset must be set

Switching off
UPS1600

)l

Figure 5-1

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
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Function blocks

5.1 Function and task of the function blocks

Notes regarding the FB1
e If the UPS1600 returns to the normal mode when the timer is running, the parameter
UPSReadyForReset is not set.

The timer is then reset.
* After the parameter UPSExecuteReset is set, the further program sequence is executed
until UPS1600 is switched off via the FB1.

e The buffer time of UPS1600 must be set such that there is sufficient time to bring the
plant into a safe state and switch off the UPS via the FB1.

Notes regarding the FB2

* In Report system error system diagnostics blocks, alarm messages will not include
extended error information. So in order to show detailed message of interrupt, FB2 is
developed. If we use this block, no need to generate system diagnostic blocks using RSE

(Report system error).

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
Function Manual, 11.2021, A5E39439812-05-76
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Function blocks

5.2 Operating conditions

5.2 Operating conditions

Configuration
* FB1 and FB2 are approved for SIMATIC STEP 7 V5.6 and application of a CPU 300/400

* FB165 is approved for STEP 7 V16/STEP 7 Professional V16, STEP 7 V17/STEP 7 Professional
V17 and application of a CPU 300/400 or CPU 1200/1500

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
20 Function Manual, 11.2021, A5E39439812-05-76



Faceplates

The HMI faceplate displays actual values and various states of the UPS1600 on WinCC
Comfort/Advanced V16 and WinCC Professional V16.

6.1 Description

Overview

This faceplate visualizes parameters of UPS1600 on a HMI control panel.

SITOP UP51600

State t dc-ups-20a

UPS1600 and connected battery information:

UPs51600
Operating state: . Normal mode
Buffer readiness: . Ready for buffering
Charging operating state: Constant voltage charge phase
Input voltage: 23.92v Output voltage: 23.84V
Battery charge current: 2.30A Output current: 2.45A
Figure 6-1

The parameters of UPS1600 are distributed over four tabs in the faceplate, clicking on the
relevant tab displays specific information. The four tabs are:

e State

¢ Information
* Trends

* Alarms

The contents of the tabs and the parameters are described in detail in the following sections.

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
Function Manual, 11.2021, A5E39439812-05-76 21



Faceplates

6.2 State

6.2 State

This menu item displays the operating state and battery state of UPS1600.

SITOP UP51600

State t dc-ups-20a

UPS1600 and connected battery information:

UP51600

Operating state: .
Buffer readiness: .

Charging operating state:

Normal mode

Ready for buffering

Constant voltage charge phase

22

Input voltage:

Battery charge current:

The following table shows all parameters displayed under this menu with its corresponding

display names:

Output voltage: 23.84V

Qutput current: 2.45A

Display name

Parameter of the UPS

Operating state bufferMode

Buffer readiness readyForBuffering
Charging operating state chargingOpState
Input voltage inputVolt

Output voltage outputvolt

Battery charge current

measuredChargeCur

Output current

outputCur

Battery charge

batteryChargeLevel

The values of the parameters buf ferMode and readyForBuffering are output via
symbolic I/O fields. This has an indicator which is subject to the color dynamization and is
dependent on the parameter value.
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6.2 State

The following table shows the possible parameter states with its corresponding color
dynamization:

Parameter State/display name Color
Normal mode Normal mode Green
Buffer mode Yellow
Off White
Ready for buffering Ready for buffering Green
Not ready for buffering Red
Off White

Note

All the I/O fields in the faceplate are read only values.

State when Pb type BAT1600 module is connected

SITOP UP51600

State f i dc-ups-20a
UPS1600 and connected battery information:

BAT1600[1]
Operating state: . Normal operation
End of charge voltage: 27.30V
Battery voltage: 50.00V
Calculated battery health: -

NotOK  OK
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6.2 State
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The following table shows all parameters displayed under this menu with its corresponding

display names.

Display name

Parameter of the UPS

Operating state batteryOpState
End-of-charge voltage endOfChargeVolt
Battery voltage batteryvVolt

Battery charge batteryChargeLevel
Calculated battery health batteryCalcHealth

The following table shows the possible parameter states with its corresponding color

dynamization.

Parameter

Operating state

State/display name Color

Off Grey
Startup Grey
Normal operation Green
Error Red
Limited charge Yellow
Critical battery lifetime Green
End of battery lifetime Yellow
Battery replacement required Green
Battery replacement running Red
Battery replacement completed | Green
Battery replacement abort Red
Deep discharge recovery Yellow

Note

All the 1/O fields in the faceplate are read only values.
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State

State when LiFe type BAT1600 module is connected

6.2 State

SITOP UP51600

UPS1600 and connected battery information:

BAT1600[1]

Operating state:

End of charge voltage:
Battery voltage:

Battery charge:

Calculated battery health:

. Normal operation

27.30V

50.00V

Not OK oK

The following table shows all parameters displayed under this menu with its corresponding

display names.

Display name Parameter of the UPS
Operating state batteryOpState
End-of-charge voltage endOfChargeVolt
Battery voltage batteryVolt
Battery charge batteryChargelLevel
Calculated battery health batteryCalcHealth

The following table shows the possible parameter states with its corresponding color

dynamization.

Parameter

Operating state

State/display name Color

Off Grey
Startup Grey
Normal operation Green
Error Red
Limited charge Yellow
Critical battery lifetime Green
End of battery lifetime Yellow
Battery replacement required Green
Battery replacement running Red
Battery replacement completed | Green
Battery replacement abort Red
Deep discharge recovery Yellow
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6.2 State

Note

All the 1/O fields in the faceplate are read only values.

State when UPS1100 is connected

26

SITOP UP51600

State ' dc-ups-20a
UPS1600 and connected battery information:
UPS1100[1] 4
Operating state: . Normal operation
End of charge voltage: 27.30V
Battery voltage: 50.00V

The following table shows all parameters displayed under this menu with its corresponding
display names.

Display name Parameter of the UPS
Operating state batteryOpState
End-of-charge voltage endOfChargeVolt
Battery voltage batteryVolt
Battery charge batteryChargeLevel
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6.2 State

The following table shows the possible parameter states with its corresponding color
dynamization.

Parameter State/display name Color

Operating state Off Grey
Startup Grey
Normal operation Green
Error Red
Limited charge Yellow
Critical battery lifetime Green
End of battery lifetime Yellow
Battery replacement required Green
Battery replacement running Red
Battery replacement completed | Green
Battery replacement abort Red
Deep discharge recovery Yellow

State when a 3™ party battery is connected

SITOP UP51600

State dc-ups-20a
UP51600 Third-party battery
Operating state: . Normal mode
Buffer readiness: . Ready for buffering
Charging operating state: Constant voltage charge phase
Input voltage: 24.00V Output voltage: 23.84V
Battery charge current: 2.30A Output current: 2.45A
Note

All the I/O fields in the faceplate are read only values.
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6.2 State

State when no battery is connected
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Operating state:

Buffer readiness:

Charging operating state:

Input voltage:

Battery charge current:

23.91V

0.00A

SITOP UPS1600

State

ups1600ghi

UPS1600 and connected battery information:

UP51600

Normal mode

Not ready for buffering

Off

Output voltage: 23.97V

Qutput current: 0.00A
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Information

6.3 Information

This menu displays general device information about UPS1600.

SITOP UP51600

Information

Device name:
Article no.:
Serial number:

HW revision:

SW revision:

Figure 6-2

dc-ups-20a

dc-ups-20a
6EP4136-3AB00-2AY0
QEMSATBAGSG

8

VZ2.4.0

The following table shows all parameters displayed under this menu with its corresponding

display names:

Table 6- 1
Display name Parameter of the UPS
Device name deviceName
Article no. orderNumber
Serial number serialNumber
HW revision deviceHwRevision
SW revision deviceSwRevisionl, deviceSwRevision2,

and deviceSwRevision3
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6.4 Trends

6.4 Trends

Description
The "Trends" tab displays the following attributes of UPS1600 in trend curves:
* UPS Input voltage
* UPS Output voltage
e UPS Output current
* Battery voltage

» Battery charge current

SITOP UPS1600

Trends dc-ups-20a
50 30 g UPSs Input voltage
404 ; I UPS Output voltage
- 2 W ups output current
Battery voltage
20
r10 [l Battery charge current
10
A 0] . Y
3:37:45 PM 3:38:35 PM 3:39:25 PM
3/12/2020 3/12/2020 3/12{2020
Figure 6-3

The time range of the X axis of the trend curve is 100 seconds. The trend variables used have
an acquisition cycle of 1 second and are refreshed cyclically.

The table below describes UPS1600 parameters with their respective display names, color
and unit representation:

Table 6- 2
Display name Parameter of the UPS Color Unit
UPS Input voltage inputVolt Green V
UPS Output voltage outputVolt Black v
UPS Output current outputCur Red A
Battery voltage batteryVolt Yellow v
Battery charge current |measuredChargeCur Blue A
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6.5 Alarms

6.5 Alarms

Description
The "Alarms" tab displays PROFINET diagnostic messages of SITOP UPS1600.

SITOP UPS1600

Alarms dc-ups-20a

Alarm history:

Pending alarms: OPEN

Figure 6-4

When you click on "OPEN" for Pending alarms and Alarm history buttons, two separate
message windows open.

The message window for "Pending alarms" displays all currently pending PROFINET diagnostic
messages of the UPS1600. The message window for "Alarm history" displays all PROFINET
diagnostic messages of UPS1600 stored in the internal message buffer of the HMI control
panel used.

Prerequisites for displaying the PROFINET diagnostic messages

In order to display PROFINET diagnostic messages of UPS1600 within the faceplate, the
respective WinCC flexible/WinCC TIA Portal project must be configured.

A list of the PROFINET diagnostic messages of UPS1600 is available in the chapter 4 of the
SITOP UPS1600 User Manual
(https:/Isupport.industry.siemens.com/cs/ww/en/view/84977415).
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6.5 Alarms
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

7.1.1 Prerequisites

FB1 requirements

The following requirements must be met in order to use the FB in combination with UPS1600
and SIMATIC STEP 7 V5.6:

e The GSD file of the UPS1600 is installed in the Hardware (HW) configuration of SIMATIC
STEP 7 V5.6 and the UPS is configured as PROFINET node in the HW configuration of the
SIMATIC S7 controller.

e S7 communication between UPS1600 and SIMATIC S7 controller is already configured.
e The library UPS1600 V3-1 STEP7 V5.6 is available on your computer.

Installation of GSD file

The required information about installation of the GSD file of the UPS1600 in SIMATIC STEP 7
V5.6 is available in the chapter 3.4.2 of the SITOP UPS1600 User Manual.
(https://lsupport.industry.siemens.com/cs/ww/en/view/84977415)

S7 communication

The required information about establishing communication between a UPS1600 and a
SIMATIC S7 controller is available in the chapter 3.4 of the SITOP UPS1600 User Manual
(https:/lsupport.industry.siemens.com/cs/ww/en/view/84977415).
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

7.1.2

Content of the library for SIMATIC STEP 7 V5.6

Content of the library for SIMATIC STEP 7 V5.6

The library UPS1600 V3-1 STEP7 V5.6 contains:

* Blocks (FB1, FB2, UDT1 and UDT2)

* Symbol table Symbols_UPS1600

* SCL source file of the code blocks FB1, FB2, UDT1 and UDT2
* "Text Libraries"

The table below shows the blocks available in the library.

Table 7-1
Block Name Description
FB1 UPS1600 FB for program-controlled switch-off of the UPS1600
UDT1 LUPS1600_typeUPS1600Data UDT provides the structure in the global data block for
data exchange
FB2 UPS16Msg FB to raise UPS1600 diagnostic alarms
uDT2 SStartinf UDT structure of local data of OB82

Opening the library in SIMATIC STEP 7 V5.6

34

Follow the procedure to open the library in a SIMATIC STEP 7 V5.6 project:
1. Open SIMATIC Manager.

2. In the menu bar, click "File > Open".
The "Open Project" dialog box opens.
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

3. Select the "Libraries" tab.

o a

Open Project @

IUser projects  Libraries ]Sample proiects] Multipmiects]

MName I Storage path -
& CFC Library C:\Program Files [x86SIEMENSAY = ’
@ LavishTry_Lib C:A\Program Files [«8ENSIEMEMSANE —
@ PCS 7 AP Library V81 C:APragram Files [«865SIEMENSAE
2 PCS 7 BasisLibrary V81 C:\Program Files [«86MSIEMEMSAE
@ PCS7_KT_Lib C:%Program Files (#8E\SIEMENSAS
& PSUSE00 V2 STEP7 VS C:\Program Files (#BE\SIEMEMNSAE
2 PSUSE00 STEP7 vE_5 D:SLibrant 102379345 SITOP_PSI
& PSUSE00 Y2 STEPT VS D:\Sthapril\102379345_SITOP_PS _
) F—"— [l

Selected

User projects: [

Libraries:
Sample projects: \
Multiprojects: [

Browse...
Ok | Cancel I Help

Figure 7-1

4. Click "Browse".
The "Browse" dialog box opens.
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

5. Navigate to the stored location of the library in your computer and open the folders "SITOP-
UPS1600_Library STEP7-V5_V3-1 > UPS1600 V3-1 STEP7 V5.6".

6. Select "UPS1600 " and click "OK".

-

Browvse
Find in directarny: Found Selected
12021 -05-17WUPS1600 v3-1 STEPT WS E\Upsigon_  User projects:

Libraries: 1 1

SR Sample projects:

- SITOP-UPSTE00 Libray STER7HE o Mulliproiects

" UPS1800%3-1 librar WinCC fles User projects  Libraries | Sample projects | Multiprajects 1
UPS1600%3-1 library WinCC W7
UPS1600%31 library WinCZC W7 et I Sterage path

. UPS1E00Y3-1 STEFY V5.6
259 @ :

Mew folder

old

PSUSE00Y3-2 libram WinCC V7.4
SITOP-UPS1600_Libray STEPTAE_WZ
Updated -

-f?f-. r

EFUPS1600Y3 ... CA\Jsers\AdministratorsD esktophMapl 7_Final

[m

T

i | [Tl 3

Cancel Help

Figure 7-2
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

7.1.3 Interfaces of the function block

Block diagram

The following figure shows the block diagram of FB1:

DBE3
"OPsle00_
DE"

FE1
"Opsle0ont
-|EN ENO —

—addrIn UPEReadyF

orReset
cyclicIOd
—{ddr

UPSExecut
—{eReset

—data

Figure 7-3

Interface description

The table below describes parameters of FB1:

Table 7- 2

Parameter Declaration | Data type Description

addrIn Input DWORD PROFINET diagnostic address of
the UPS1600 within the project.
The diagnostic address must be
specified in hexadecimal format.

cyclicIOAddr Input WORD Input address of the UPS1600
within the project.
The input address must be
specified in hexadecimal format.

UPSExecuteReset Input BOOL Switch-off signal to the UPS1600.

UPSReadyForReset | Qutput BOOL Signal for plant shut-down.

data InOut LUPS1600_typeUPS1600 | Data area for data exchange to

Data the HMI faceplate.
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

The table below describes parameters of FB2:

Table 7- 3
Parameter Declaration Data type Description
Diag Address Input INT PROFINET diagnostic
address of the UPS1600
within the project. The
diagnostic address must
be specified in decimal
format.
MsgEvId100 01 Input DWORD Message event ids for
MsgEvId100—27 Device failures alarms
MsgEvIdlOl 01 .. Input DWORD Message event ids for
MsgEvId101727 Device Diagnostic
alarms
MsgEvId102 01 Input DWORD Message event ids for
MsgEvId102712 Battery Diagnostic
alarms

Input and diagnostic address of the UPS1600 module

38

To fetch the input and diagnostic address of the UPS1600 module, follow the instructions
given below:

1. Open the hardware configuration settings of the PLC used in the project. The "HW Config -
[SIMATIC 400(1) (Configuration)..." dialog box opens.

2. Select the UPS1600 module.

3. Note down the value in the "Diagnostic Address" column (A). We need to add value to the
given parameter addrIn of FB1 and Diag Address of FB2.
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4. Note down value in the "| Address" column (B), value given to the parameter
cyclicIOAddr of FB1.

) SIMATIC 400(1) (Configuration) -- UPS Test
o) uR2aLU H
1 PS 407 44 - E
2 CPU 416-3PN/DP | |
l;; T Ethernet(1]): PROFINET 10 system (100]
X5 0] =l L
X5P1A Porr 1
X5P2R Poit 2
4 L ﬁ 20
5
5 =
< | mn »
R e U
Slot Module Order number | Address | (Laddress | Diagnostic Address Com...
& upsil EEPS 13638002370 (A)—ll7&z7%- | -
Desive santanace Pesins snianace JEFE B
AR A7
AR A =
ar LIPSIEAT A3 A
&z LIFSTERT 0 Y gz 518 | [——B L
1 UPS1100 DC 24V 1,28k 10~ 6EP4131-0GB00-04Y0 16374*
2
3 -
Figure 7-4
In this case,
e addriInvalueis 16375.
e cyclicIOAddris512.
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

7.1.4

LUPS1600_typeUPS1600Data (UDT1)

Data block DB15

40

The Data Block (DB) contains all the parameters of UPS1600 displayed within the HMI

faceplate.

The following table lists all the parameters in UDT1:

Parameter Data type Remarks

orderNumber STRING [20] Order number

serialNumber STRING [20] Serial number

deviceName STRING [20] Device name

versionNumber STRING [30] Version number

chargingOpState BYTE Status of chraging unit/Value range: 0-4

numOfBatteries BYTE Number of batteries/Value range: 0-6

batFamily BYTE Battery family/ Value range: BAT1600 = 1, UPS1100 =
2, Third-party battery = 3

batType BYTE Type of battery identifier/Value range: Pb =0, Li=1

BAT1LEDState BYTE Signaling/ Value range: Bit0/1: Color O = Green/read
alternating 1 =red, 2 = green, 3 = yellow, Bit2/3:
State 0 = off 1 =on

BAT1OpState BYTE Battery status/Value range: 0-11

BAT1CalcHealth BYTE Calculated battery health/ Value range: 0-100

BAT2LEDState BYTE Signaling/ Value range: Bit0/1: Color O = Green/read
alternating 1 =red, 2 = green, 3 = yellow, Bit2/3:
State 0 =off 1 =on

BAT20pState BYTE Battery status/Value range: 0-11

BAT2CalcHealth BYTE Calculated battery health/ Value range: 0-100

BAT3LEDState BYTE Signaling/ Value range: Bit0/1: Color O = Green/read
alternating 1 =red, 2 = green, 3 = yellow, Bit2/3:
State 0 = off 1 =on

BAT30pState BYTE Battery status/Value range: 0-11

BAT3CalcHealth BYTE Calculated battery health/ Value range: 0-100

BAT4LEDState BYTE Signaling/ Value range: Bit0/1: Color O = Green/read
alternating 1 =red, 2 = green, 3 = yellow, Bit2/3:
State 0 =off 1 =on

BAT40pState BYTE Battery status/Value range: 0-11

BAT4CalcHealth BYTE Calculated battery health/ Value range: 0-100

BAT5LEDState BYTE Signaling/ Value range: Bit0/1: Color O = Green/read
alternating 1 =red, 2 = green, 3 = yellow, Bit2/3:
State 0 = off 1 =on

BATS5OpState BYTE Battery status/Value range: 0-11

BAT5CalcHealth BYTE Calculated battery health/ Value range: 0-100

BAT6LEDState BYTE Signaling/ Value range: Bit0/1: Color O = Green/read
alternating 1 =red, 2 = green, 3 = yellow, Bit2/3:
State 0 =off 1 =on

BAT60pState BYTE Battery status/Value range: 0-11

BAT6CalcHealth BYTE Calculated battery health/ Value range: 0-100

endOfChargeVolt REAL End of charge voltage [V]

chargeCur REAL Charge current [A]
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

Parameter Data type Remarks

maxOutCur BYTE Maximum output current [A]

inputvolt REAL Input Voltage [V]

inputCur REAL Input current [A]

outputVolt REAL Output voltage [V]

loadCur REAL Load current [A]

measuredChargeCur REAL Measured charge current [A]

batteryVolt REAL Battery voltage [V]

outputCur REAL Output current [A]

chargeVolt REAL Charge volatge [V]

bufferMode BYTE Active = 255 Inactive = 0; Undefined = 127

readyForBuffering BYTE Yes = 255; No=0

batteryChargeLevel BYTE 0 to 100% = battery charging; 255 = unknown
battery

totalCalcBatCap REAL Total calculated battery capacity [Ah]

totalCalcBatHealth BYTE Total calculated battery health [%]

bufferTime INT Buffer time [s]

bufferThreshold REAL Buffer threshold [V]

bufferingAllowed BYTE Buffering allowed [0/255]

commandID INT Command ID (Remote reset = 8207)

parameterl BYTE Parameter value 1

parameter?2 BYTE Parameter value 2

deviceHWRevision INT Device hardware revision

deviceSWRevisionl BYTE Device software revision 1

deviceSWRevision2 BYTE Device software revision 2

deviceSWRevision3 BYTE Device software revision 3

Note

Further information about the system parameters is available in the SITOP UPS1600 User
Manual (https://support.industry.siemens.com/cs/ww/en/view/84977415).
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

7.1.5 Integrating the function block

Integrating FB1

The following sections describe all the steps required to integrate FB1 into a SIMATIC STEP 7
V5.6 project.

Hardware used:

* CPU317-2 PN/DP

* SITOP UPS1600 24 VI20 A

The procedure for other SIMATIC S7 controllers is identical.

Note

Please ensure that all requirements for the integration of the FB are met. The requirements
are described in these Prerequisites (Page 33).

Inserting blocks from the library into the program

Follow the procedure to integrate FB1 and associated data blocks into a SIMATIC STEP 7 V5.6
project:

1. In the "SIMATIC Manager", open the required project.

2. Open the "Blocks" folder available in the connected PLC.

3. In the "SIMATIC Manager", open the global library UPS1600 V3_1 STEP7 V5_6 and select
"UPS1600 V3 1 > Blocks".
The procedure for opening the library is described in Content of the library for SIMATIC
STEP 7 V5.6 (Page 34).
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

4. Select all the blocks in the library and drag-and-drop them into the "Blocks" folder of your

target project folder.

-

&2 UPS1600 3_1 STEPT W/5_6 -- C\sers\.. \UPS1600 4/3-1 STEPT V5.64ps1600_

=6 UPS1600Y3_1 STEF7 Y5 6 |43 FB1 i FB2 o UDTm o UDT2 &3 5FBd
-7 UPS1800_Y3_1 SFEGZ2 &3 5FBS3 &3 SFBS4 &3 SFC6 &3 SFC14
(] Souces SFC18 & SFC20 & SFCE0 &3 SFC70 &3 SFC71

@ Testl -- CihProgram Files (B804 Siernens\StepThsTprojiTestl

3 Spstern data o+ OB1

E]@ Testl
=l SIMATIC 400(1)
- =@ cruse3PN/OP
E-{z7] 57 Program(1]
-{B] Sources
-8, SIMATIC PC Station(1]

Figure 7-5

v

Note

The function blocks work properly with both, English and German mnemonics. In case the
source code of the function blocks is required for a project, consider the following

constraints:

In case the language setting of your project is English, then the source code of the

function blocks can be used as it is.

In case the language setting of your project is German, then the entries IB (Input Byte)

and IW (Input Word) of the sources have to be replaced with EB (EingangsByte) and EW

(EingangsWort).

5. Insert OB40 in order to avoid PLC going to stop mode in case of hardware interrupt.
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7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

Inserting Text libraries from the library into the program

Follow the procedure to insert "Text Libraries" from the library into a SIMATIC STEP 7 V5.6
project:

1.
2.

7.

In the "SIMATIC Manager", open the required project.

Open the "S7 Program" folder available in the connected PLC. Insert Text Library folder under
S7 Program folder if it doesn't exist.

In the "SIMATIC Manager", open the global library UPS1600 V3_1 STEP 7 V5_6 and select
"UPS1600_V3_1".

. The procedure for opening the library is described in Content of the library for SIMATIC

STEP 7 V5.6.

Copy "SITOP_MODULES", "SITOP_UPS1600_DiagText", "SITOP_UPS1600_HIpText" which are
present under "Text Libraries" folder in the library and paste them into the "Text Libraries"
folder of target project folder.

. Open text library "SITOP_MODULES" and make an entry to the text library with index as

modules diagnostic address and PSU8600/UPS1600 device name under English/ German
Language column as shown below.

é‘?‘ At usertes iy = SEIFS_DesbSIRAS D 0AI R 2 =TEETF- 1 =B 1=tear P el et Dibcsoe sl Eoe=_SA00HE 5
I=cte  Tdim A ewr Whc-domre Tel-

CEld &S - = T N

F] WUPE Tes AEIRAATIC 4006100 230 206-3 Sk 32457 Proyraind i Tevl Libeari 2\ ITO=_RACDULZE
Ladex Engliceh (United Etates]
1 | l16:z73 ==

Figure 7-6

Save and close text library.

Create a global data block with UDT structure

Follow the procedure to create a global DB with UDT:

1.
2.

44

In your project, open the "Blocks" folder available in the connected PLC folder.
Right-click on the blocks element area and select "Insert New Object > Data Block".

The "Properties - Data Block" dialog box opens to create a DB.
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3. In the "Properties - Data Block" dialog box,

— Enter a name and number for the DB (DB15) in the "Name and type:" text box.

— For the same field, open the first drop-down list and select "Shared DB".

— Enter a symbolic name as desired (UPS_Global) in the "Symbolic Name:" text box.

-

Properties - Data Block
General - Part 1 ‘ General - Part 2 ] Calls ] Attributes I

Mame and type: |DB'I 5 IShaled DE LI I _I

Symbolic Name: |UPS_Glabal

Symbol Comment: I

Created in Language: DE -

Project path: |

St locati

St [C:\Program Files (<86]\SIEMENS\STEP7\s7projPrajsct_

Code Interface

Date created: 09/15/2016 171:38:06 Ak

Last modified: 09/15/2016 11:38:06 AM 09/15/2016 11:38:06 A

Camment; =
Cancel Help

Figure 7-7

4. Click "OK".

The created DB appears in the "Blocks" folder.

5. Open the DB created in Step 2 (DB15).

A new window opens.
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6. At the address "+0.0",
— Inthe "Name" column, enter a name for your tag (UPS).
— Inthe "Type" column, replace INT with LUPS1600_typeUPS1600Data.

— In the "Initial" column, delete the initial value and remove the comment.

hddress |Name Type Initial walue |[Comment
0. STRUCT
+0.0 DB_VARI INT | u} Temporary placeholder wariahle
=E.0 END_STRUCT
hddreszs |Name Type Initial value [Comment
0.0 v STRUCT v
+0.0 |UPS "LUPE1E00_typeUPS1600Data"
=194.0 NI STREUCT
Figure 7-8

7. Save the settings and close the window.

Calling the function block FB1

Follow the procedure to call the FB within an organization block (OB). In this description, FB1
is called within OB33:

1. In the "Blocks" folder of the controller, create an instance DB.

2. Right click on the blocks element area and select "Insert New Object > Data block". The
"Properties - Data Block" dialog box opens.
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3. In the "Properties - Data Block" dialog box,

Enter a name and number for the DB (DB3) in the "Name and type:" text box.

For the same field, select "Instance DB" and "FB1" from the drop-down lists.

Enter the symbolic name as "UPS1600_DB" in the "Symbolic name:" text box.

Click "OK".

Froperties - Data Block @
General - Part 1 | General - Part 2 ] Calls ] Abtributes |

Marme and type: |DBS |Instance [u]:] j |FB1 j

Symbaolic: Mane: |UF'S'I £00_DE|

Symbal Carmment: |

Created in Language: 0]} -

Project path: |

S loc:ati

Drc;;gij:cgca on |EI:\Usersk&dministrator'\Desktop\UF’S_Test

Code Interface

Date created: 01/27/2020 17 35: 44 AM

Lasgt modified: 01/27/2020 17 35: 44 AM /27,2020 11:35:44 AM

Conment: "
Cancel Help

F

igure 7-9
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4. In the same "Blocks" folder, create an Organization Block (OB) with the name OB33. (Right
click and select "Insert New Object > Organization block".)

Open the created OB33.

[i% LAD/STL/FBD - [0B33 -- "CYC_INT3" -- Project UPS16005SIMATIC 300(LACPU 317-2 PM/DPL.AOB... [ = |[ & |[25]
iF File Edit Insert PLC Debug \View Options Window Help [=][=] ]
DS E &2 | a | 25 6
ot O e b4 0OF L 1|2
e

|Contents 0f: 'Environment)Interface'

E"@ Interface |Nane
B New network - & TEMP 4a| TEMP
{31 Bit logic I a
(X1 Comparator
(&g Converter

{#4] Counter 0B33 : "Cyclic Interrupt" [l
(o8] DB call i

H
H
H
H
H
1-(5] Jumps
.
:I.
:I.
:I.
:I.

Comment :

{z1] Integer function
(£%] Floating-point fci B : Tivle:
(= Move

{3 Program contral
() Shift/Rotate
b7 Status bits

i-(m] Timers i
1-{Z “Word logic
78 FB blocks
1-igH FC blocks

FEm O = O B rm N = O B e W = B e WO = O v

eI =i =]

el

-

Figure 7-10

5. In the "Program elements" tab, expand the "FB blocks" folder.
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6. Drag-and-drop "FB1 UPS1600 UPS1600" onto the empty network area.

[%% LAD/STL/FBD - [OB33 -- "CYC_INT3" -- MayT_Final\SIMATIC 400(IACPL 416-3 PN/DPY.ADB33]
& Lt
iF File Edit Insert PLC Debug “iew Options Window Help

D@ W& 2R o o tids|al2a | <! O] &=

1k 4

x|

Contents 0f: 'Enwvironme

{5 Jumps

(s3] Integer function
[s#] Floating-paint fct.
(=] Move

{3f Program control
A-(z] Shift/Rotate

7 Status bits

(@] Timers

(33 Word logic

=-{£H FB blocks

]

@-igH FC blocks

B-{£H SFEB blocks

B-IgH SFC blocks

----- Al Multiple instances
E- 1 Libraries

IS AFEL UPSIG00 LIPS1600 -

.40 FB2 UPS16Msg UPS1600

E"@ Interface
- TEMP

Name
& | TEMP
L=

e

EN

S UPS1600

%

N Progran ... |E_E Call str... J

EE Metworks ]

Figure 7-11

» .. —fjaddrIn

cyclicIOf
. —ddr

upsExecut
. feReset

. —data

"opsSle0ont

ENO

upsRkeadyF
orReset —1..
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7. For the block in the network area,
— Interconnect FB1 with the instance DB created in step 1 (DB3).

— For the parameter addrIn, enter the PROFINET diagnostic address of the SITOP
UPS1600 within your STEP 7 project (DW#16#3FF7).

— For the parameter cyclicIOAddr, enter the input address of the SITOP UPS1600
within your STEP 7 project (W#16#200).

— Connect the parameter UPSReadyForReset to the tag through which you bring the
plant into a safe state (flag M0.0 is used).

— Connect the parameter UPSExecuteReset to the tag through which you switch off
the UPS (flag M0.1 is used).

DE3
“TPS1600_
DE”

FB1

“UPS16007
EN ENO

DW#16#3FFT addrIn UFSEeadyF
orEezet (...

cyclicIOf

W#16#200 {ddr

TP5Execut
M0, 1 -eRezet

P2DE1. DEED
-0
“TPS_
GLOBAL™.
Ps —Hdata

Figure 7-12

For further information about the block parameters, see Interfaces of the function
block (Page 37).

8. Save the changes and close the window.

Note
addrIn and cyclicIOAddr of FB1

To know the diagnostic and input address of FB1, refer to section Input and diagnostic
address of the UPS1600 module in Interfaces of the function block (Page 37).
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Calling the function block FB2

Follow the procedure to call the FB2 within an organization block (OB). In this description,
FB2 is called within OB82:

1. In the "Blocks" folder of the controller, create an instance DB.

2. Right click on the blocks element area and select "Insert New Object > Data block". The
"Properties - Data Block" dialog box opens.

3. In the "Properties - Data Block" dialog box,
— Enter a name and number for the DB (DB2) in the "Name and type:" text box.
— For the same field, select "Instance DB" and "FB2" from the drop-down lists.

— Enter the symbolic name as "UPS1600Msg_DB" in the "Symbolic name:" text box.

— Click "OK".
Properties - Data Block @
General - Part 1 | General - Part 2] Calls I Altributes |
Mame and type: |DBZ |Instance DB j |FB2 j
Sumbolic Mame: |UF'S1 Ebdzg DB

Sumbol Comment; |

Created in Language: DB -
Project path: |
St lozat
et [C\Program Files (+BENSIEMENSNSTEPTAS 7Prof LIPS _Test
Code Interface
Date created: 042142020 11:16:35 Ak
Lazt modified: 01/21/2020 11:16:35 AM 01/21/2020 171:16:35 Ak
Comment; Jh

Cancel Help

Figure 7-13
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4. In the same "Blocks" folder, create an Organization Block (OB) with the name OB82. (Right
click and select "Insert New Object > Organization block".) Open the created OB82.

%: LAD/STL/FBD - [OB82 -- "/O_FLT1" -- Project UPS16004SIMATIC 400¢1)\CPL 416-3 PN/DPY..A0B82] =N N =<
i3 File Edit Insert PLC Debug ‘iew Options Window Help [= =] x]
DEWHS| s R|o ~|cida|2a <! OB E®E{F#-00L 21|82
:]_x_‘ Contents 0f: 'Environment)Int

E!'@ Interface [Nane =
B4 TEMP @ [TEMP

i ,'1"1 MNew netwark
{3i] Bit logic

{41 Comparator
{83 Conwverter
#4) Counter Comment:

{og] DB call

(&] Jumps = m: Title:
(21) Integer function

(28] Floating-point fct. l
(=] Move I

>

0B2Z : "If0 Point Fault' |7|

-

m

EE

[

[

{ar] Program control
{z3] Shift/Rotate

47 Status bits
=-{@] Timers

C.Q Word logic

{£H FB blocks

-fEm FC blacks i

e

13)

Il
A

[B Program elements IE_E Call structure | §= Networks I < »

Press F1to get Help, D offline |Abs < 5.2 4

Figure 7-14

5. In the "Program elements" tab, expand the "FB blocks" folder.
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6. Drag-and-drop "FB2 UPS16Msg UPS1600" onto the empty network area.

F

%% LAD/STL/FED - [OB80 -- "CYCL_FLT" -- UPS_ Test\SIMATIC 400(LACPU 416-3 PN/DPY..AOBS0] = =
iF File Edit Insert PLC Debug View Options Window Help [_ u 5’” x\
DEeH S| & 2o o|6hd|al2de ||
|
OE =S m %%k #-OFL o K2 1
x| Contents 0f: 'Environuent)Interface
E]--@ Interface |Nal|e -
B News netwark - B TEMP & [TEND
[-{&1 Bit logic B a ~
{1 Comparator o
582 Converter 0BEO : “Cycle Time Faule" 3
Counter Comment :
[-{58) DB call
@) Jumps B fatmenk 3: Tas1e:
-0 Integer function | ||| | ————
-{z8 Floating-paint fct, F
=2 Move = "UPSlEMsg"
&-@38 Program control 1 EN ENC
=-{4] Shift/Rotate
n ) Diag_
' _?fatus bits | .. —jaddress ERROR |—. ..
- Imers
&3 Word logic M= gEvIdon
£-&8 FB blocks e
--{0F FB1 UPS1600 UPS1600 = gEvIdo0
= JFE2 PS16Msg UPS1600 .. 2
=8 FC blocks L
&3 SFE blacks | ok it
&7 SFC blocks
.MMl Multivle instances i M= gEwIdo0
/UPS1600 i e
M=gEvIdoo
5 = e =
@ Program... ... | B= Metwo... - |:| s

Figure 7-15

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
Function Manual, 11.2021, A5E39439812-05-76 53



Application of the function blocks

7.1 Application of the function blocks in SIMATIC STEP 7 V5.6

54

8.

. For the block in the network area,

— Interconnect FB2 with the instance DB created in step 1 (DB2).

— For the parameter Diag Address, enter the PROFINET diagnostic address of the
SITOP UPS1600 within your SIMATIC STEP 7 project (16375).

DBEZ

"UPE1eMsg_

DE"

16375

DWElegc0non
0001 —

DWElegc0non
000z

DWElegc0non
0003 —

DWElegc0non
0004 —

DWElegc0non
0005 —

DWElegc0non
0o0s —

DWElegc0non
0oo7

DWElegc0non
0oo0s —

DWElegc0non
0005 —

DWElegc0non
0004 —

DWElegc0non
000E —

DWElegc0non
0ooc —

Figure 7-16

Save the changes and close the window.

FEZ

"OPS1leM=g"

EN

Diag
ALddress

HM=gEvwIdon
1

HM=gEvwIdon
z

HM=gEvwIdon
3

HM=gEvwIdon
4

HM=gEvwIdon
13

HM=gEvwIdon
&

HM=gEvwIdon
7

HM=gEvwIdon
g

HM=gEvwIdon
3

M=gEvIdol
a

M=gEvIdol
1

M=gEvIdol
z

ENO

ERROR

Follow the same procedure to call FB2 in OB86 and cyclic interrupt OB. In this example OB33

with the same instance DB which is created in step 3.

Note
Diag_Address of FB2

To know the diagnostic and input address of FB2, refer to section Input and diagnostic
address of the UPS1600 module in Interfaces of the function block (Page 37)
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7.2 Application of the function blocks under STEP 7 Professional V16

7.2.1 Prerequisites

Requirements

The following requirements must be met in order to use the FB in combination with UPS1600
and STEP 7 V16:

* Hardware Support Package (HSP) for UPS1600 is installed in STEP 7 V16.
e S7 communication between UPS1600 and SIMATIC S7 controller is already configured.

e LUPS1600 is available on your computer.

Installation of Hardware Support Package

The required information about installation of Hardware Support Package of UPS1600 in
STEP 7 V16 is available in the chapter 3.3.2 of the SITOP UPS1600 User Manual
(https:/Isupport.industry.siemens.com/cs/ww/en/view/84977415).

S7 communication

The required information about establishing communication between UPS1600 and a
SIMATIC S7 controller is available in the chapter 3.3 of the SITOP UPS1600 User Manual
(https:/Isupport.industry.siemens.com/cs/ww/en/view/84977415).

7.2.2 Content of the library for STEP 7 V16

Content of the library for STEP 7 V16
The STEP 7 V16 library contains the library elements for:
» S7-300/400
* S7-1200/1500

The following sections describes in detail about the library elements and how to open the
library in STEP 7 V16.

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7
Function Manual, 11.2021, A5E39439812-05-76 55


https://support.industry.siemens.com/cs/ww/en/view/84977415
https://support.industry.siemens.com/cs/ww/en/view/84977415

Application of the function blocks

7.2 Application of the function blocks under STEP 7 Professional V16

Library elements S7-300/400 and S7-1200/1500

The following code blocks are present in this library element:

Table 7- 4
Folder | Description
FB It contains the LUPS1600_UPS1600 function block for program-controlled switch-off of the
UPS1600.
ubDT LUPS1600_typeUPS1600Data UDT stores all parameters of UPS1600.

Opening the library in STEP 7 V16
Follow the procedure to open the library in STEP 7 V16 project:

56

1. Open STEP 7 V16 in the "Project view" and select the "Libraries" tab.

2. Under the "Global libraries" palette, click on the highlighted icon to import the library. The
"Open global library" dialog box opens.

Libraries w0 p

Options

| Library view 2] O

W

Global libraries

2] © EIEE
» LL| Buttons-and-Switches

» Ll Long Functions
» LI Menitoring-and-control-objects

» Ll Documentation templates
» L[] winAC_mP

Figure 7-17

3. In the "Look in:" drop-down list, navigate to the stored location of the library folder
LUPS1600 on your computer and open it.
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4. Select "LUPS1600".

Lack in: LUPS 1500 ~ @2 M
= Marne - * | Date rmodified Type
e AdditionalFiles 32042019 2:22 PM File folder
Recent Places M 3/20/2019 2:22 PM  File folder
! System 372072019 2:22 PR File folder
ThP 3202019 222 PR File folder
Desktop serFiles 32042019 2:22 PM File folder
— | ¥Ref 3202019 222 PR File folder
_:T_J E LUPE1600 3/12/2018 3:55 PM Siermens T
Libraries
; .
==
Cormputer
@ <l ] b
4 File name: LUPSTE00 - Open
Metniork _—
Filez of type: [Global library v] [ Cancel ]
Open as read-only
Figure 7-18
5. Click "Open".

The library is displayed in the "Global libraries" palette.
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7.2.3 Interfaces of the function block FB165

Function block FB165 for S7-300/400
Block diagram

The following figure shows the block diagram of FB165:

%OB1
"LUPS1600_
UFS1600_DE"
WFE165
"LUPS1600_UPs1600"
= Ep EMO —
addrln upsReadyForRe
cycliciCAaddr set —
upsExecuteRes
- et
data
Figure 7-19

Interface description

Parameter Declaration | Data type Description

addrIn Input DWORD PROFINET diagnostic address of
the UPS1600 within the project.
The input address can be
specified in both hexadecimal
and decimal format.

cyclicIOAddr Input WORD I/0O Data input address of
UPS1600 within the project. The
input address can be specified in
both hexadecimal and decimal
format.

upsExecuteReset Input BOOL Switch-off signal to the UPS1600

data InOut LUPS1600_typeUPS1600 | Data area for data exchange to

Data the HMI faceplate.
upsReadyForReset | Qutput BOOL Signal for plant shut-down
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addrIn and cyclicIOAddr of FB165 for S7-300/400

To fetch the input and diagnostic address of the UPS1600 module for S7-300/400, follow the
instructions given below:

1. Inthe "Project tree", open "Devices and Networks".
2. Select the UPS1600 module and go to "Device view > Device overview".

3. Note down the value in the "l address" column (A), this value is given to the parameter
addrIn.

4. Select the UPS1600 module and go to "Properties > General > I/O data > I/0 addresses >
Input addresses”

5. Note down the value in the "Start address" variable (B), this value is given to the parameter
cyclicIOAddr.

Project_LUP51600 » Ungrouped devices » DC-UPS-20A_1 [UPS1600 20A PN]

IE Topology view ||Egb Network view "[h‘ Device view L
ﬂ*ﬂ" ' H J Device overview [
¥/ .. |Module Rack slot | address
~ DCUPS-20A_1 0 @—
| » PROFINETinterface 0 0 Devi... 2041*
i ] 1
- 0 2
L 0 3
0 o 4
Rack_0 0 5
o 6
<[ e <] I | >
: ' ' l_@, Properties “"_i.'.lnfo Hﬂ Diagnostics |
J General || 10 tags ” System constants || Texts |
b General [ IO add
» PROFINETinterface [X3] =
PROFINET security Input addresses
» Device configuration
w IO data Startaddress: |256 I—@) |
jen=el End address: |263 |
Inputs - ———
Process image: Ir-lcn:
» Web server Interrupt OB number: |40
Figure 7-20
In this case,

* Value of addrInis 2042 (A).
e Value of cyclicIOAddr is 256 (B).
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Function block FB165 for S7-1200/1500

60

Block diagram

The following figure shows the block diagram of the FB165:

HWOET
"LUPS1600_
UPS1600_DE"

HFET1ES
"LUPS1600_UPS1600"

= EM EMO =—

addrln upsReadyForke
cycliclOAddr ST

upsExecuteRes
— et

data

Interface description

Table 7-5

Parameter Declaration | Data type Description

addrIn Input HW_IO Hardware ID of the UPS1600
within the project, for example:
DC-UPS-20A_1~Head.

cyclicIOAddr Input HW_I0 IO Data submodule address of
UPS1600 within the project

upskEecuteReset Input BOOL Switch-off signal to the UPS1600

data InOut LUPS1600_typeUPS1600 | Data area for data exchange to the

Data HMI faceplate.
upsReadyForReset | Qutput BOOL Signal for plant shut-down
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addrIn and cyclicIOAddr of FB165 for S7-1200/1500

To fetch the input and diagnostic address of the UPS1600 module for S7-1200/1500, follow

the instructions given below:

1. Inthe "Project tree", open "Devices and Networks".

2. In the "Network view", select the UPS1600 module and go to "Properties > System

constants".

3. Note down the value in the "Hardware identifier" column of DC-UPS-20A_1~Head (A), value

given to addrIn.

4. Note down the value in "Hardware identifier" column of DC-UPS-
20A_1~l0_Data_Submodule (B), value given to cyclicIOAddr.

Project_UPS1600 » Devices & networks

|; Topology view "ﬁg-n Network view ||[|‘f Device view |

& Metwork un Conhnections |Hr-.-11 cohnection |'| & Relations B EI;, r H
PLC_1 DCUPS-204_1 HrAIL_ -
CFU 12142 UPS1600 204 PN TP1200 Comfort 1
L3
| PNAE_T
[<]m] 100% o —5— @
|g Properties ”"iilnfu y“ﬂ Diagnostics |
| General ” 10 tags " System constants || Texts |
Marne Type Hardware iden... Comment
Hardware interrupt Event_Hwint 16#C0000112
DC-UPS-20A_1~Proxy Hw_SubModule 272
DC-UPS-204_1~Head Hw_SubModule 273 —@
DC-UPS-204_1~10-Data_submodule Hw_SubModule 274
DiC-UPS-20A_1~FROFINET intedace Huw_Interface 275
DC-UPS-204A_1~FROFIMET interface~Fort_1 Hw_Interace 276
DiC-UPS-20A_1~FROFIMET intedace~Fort_2 Hw_Intedace 277

Figure 7-21

In this case,

e Value of addrIn is DC-UPS-20A_1~Head or 273 (A).
* Value of cyclicIOAddr is DC-UPS-20A_1~I0-Data_Submodule or 274 (B).
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7.2.4
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LUPS1600_typeUPS1600Data

The data block contains parameters of UPS1600 displayed within the HMI faceplate.

The following table lists parameters present in LUPS1600_typeUS1600Data:

Parameter Data type Remarks

orderNumber STRING [20] Order number (String)

serialNumber STRING [20] Serial number (String)

deviceName STRING [20] Device name (String)

versionNumber STRING [30] Version number (String)

chargingOpState BYTE Status of charging unit //Value range: 0 -4

numOfBatteries BYTE Number of batteries //Value range: 0 -6

batFamily BYTE Battery family //Value range: BAT1600 = 1, UPS1100 = 2,
Third-party battery = 3

batteryType BYTE Type of battery identifier //Value range: Pb =0, Li =1

batteryDetails ARRAY [0...5]

endOfChargeVolt REAL [V]

chargeCur REAL [A]

maxOutCur BYTE [A]

inputvVolt REAL [V]

inputCur REAL [A]

outputVolt REAL [V]

loadCur REAL [A]

measuredChargeCur |REAL [A]

batteryVolt REAL [V]

outputCur REAL [A]

chargevolt REAL [V]

bufferMode BYTE Active = 255 Inactive = 0; Undefined = 127

readyForBuffering BYTE Yes = 255; No=0

batteryChargeLevel |BYTE 0 to 100% = battery charging; 255 = unknown battery

totalCalcBatCap REAL [Ah]

bufferTime INT [s]

bufferThreshold REAL [V]

bufferingAllowed BYTE [0/255]

commandID INT Remote reset = 8195

parameterl BYTE -

parameter?2 BYTE -

deviceHWRevision INT -

deviceSWRevisionl |BYTE -

deviceSWRevision2 BYTE -

deviceSWRevision3 |BYTE -
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7.2 Application of the function blocks under STEP 7 Professional V16

7.2.5 Integrating the function block
7.2.5.1 Procedure when using an S7-300/400
Overview

Hardware used:

* CPU 315-2 PN/DP

* SITOP UPS1600 24V/20A

The procedure for other SIMATIC S7-300/400 controllers is identical.

Note

Please ensure that all the requirements for the integration of the FB are met. The
requirements are described in the Prerequisites (Page 55).

Inserting blocks from the library into the program

Follow the procedure to insert the FB165 and associated data blocks into a STEP 7 V16
project:

1. Open the required project in "Project view".
2. In the "Libraries" window, under "Global libraries", open the library "LUPS1600".

The procedure for opening LUPS1600 global library is described in Content of the library in
STEP 7 V16 (Page 55).
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3. Inthe library, select "Types > LUPS1600 > STEP7 > S7-300/400 > FB > LUPS1600_UPS1600".

64

Libraries a0 p
Options g
: —
] Libranyview & | w
=
>  Project library -
~ | Global libraries ]|
Fdhnd B EH’|C
» Ll Buttons-and-Switches §
» Ll Long Functions E

» LLI Monitaring-and-control-abjects
» LL| Documentation templates
w ||| LUPS1600
-~ [ Types
w [t LUPS1600
= (%] STEP?
w [t 57-300/400
v [&| FE

|» " LUPS1600_UPS1600 |

» (5 UDT
» iz 57120011500
b (5 WinCC
» [ Master copies
» [} common data
¥ Languages &resources

Figure 7-22

Project tree o 4

Devices

B

w |7 Project_LUPS1600
B Add new device
ﬁg-h Devices & networks
» ([l PLC_1 [CPU 1214C DC/DCIRNy]
~ [[j PLC_2 [CPU 315-2 PN/DP)]
I]'f Device configuration

|| online & diagnostics

[2]

» L3 Technology objects
» External source files
» [ PLCtags

» [ PLC data types
»

»

[z2 watch and force tables
[E, Online backups

Figure 7-23

4. Drag-and-drop "LUPS1600_UPS1600" into the "Program blocks" folder in the "Project tree".
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Note

Even "LUPS1600_typeUPS1600Data" will be automatically copied to the "PLC data types"
folder in the "Project tree".

Project tree o 4

Devices

s
[=

™

Bk

~ | ] Project_LUPS1600
B Add new device
o Devices & networks
» [ PLC_1 [CPU 1214C DCDCRIY]
~ [ PLC_2 [CPU 315-2 PN/DP]
Y pevice configuration
Q| online & diagnostics
» |5 Program blocks

1]

» [ Technology objects
4 External source files
» [ PLCtags
~ [fig PLC data types

E Add new data type

« [%:] LUPS1600
~ [i:] STEF?
« [i:] 57-300/400
v [&:] UDT
| # LUPS1600_typeUPS1600Data
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Calling the function block

Follow the procedure to call FB165 within an Organization Block (OB). In this description,

FB165 is called within OB35:

1. Inthe "Project tree", open the "Program blocks" folder.

2. Create a cyclic interrupt OB with the name "CYC_INT5 [OB35]" and open it. This displays an

empty network.

3. From the "Program blocks" folder, drag-and-drop "LUPS1600_UPS1600 [FB165]" to the
empty network of OB35. The "Call options" dialog box opens.

Project tree

Devices

m 4

]
=]

~ | ] Froject_LUPST600
E Add new device

i

HF HiIF 0~ — £

ﬁgh Devices & networks

= ¥ Block title: "Main Frogram Swe
» [ PLC_1 [CPU 1274C DCDGRIY]

- Comment
~ [§ PLC_2 [CPU 315-2 PN/DP]
[l‘f Device configuration - Network 1: ..
%] online & diagnostics COFRERT

= [.gl Program blocks
B Add new block
2 Main [OB1]
| 48" LUPS1600_UPS1600 [FE165] | —
» [ Technology objects

» External source files

Figure 7-24

4. Keep the default settings of the dialog box and click "OK".

5. The following OBs must be added to the project to avoid PLC going to STOP mode in case of
S7-300 & S7-400 PLC's:

— OB 40: The hardware interrupt OBs interrupt the cyclic program processing at the
occurrence of a hardware event.

— OB 82: If the diagnostics-compatible module, for which you have enabled the
diagnostic error interrupt, detects an error, the diagnostic error interrupt OB interrupts
the cyclic program processing.

— OB 83: The operating system of the CPU calls this OB when a configured and non-
disabled module or submodule of the distributed 10 is pulled or plugged.

— OB 86: When a DP master system, slave or part of the submodules fails, the operating
system of the CPU calls this OB.

6. Double click on "Add new block" to add a new DB. The "Add new block" window opens.
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7. In the "Add new block" window,

Select "Data block”

Enter a name as desired (UPS_Global).
In the "Type:" drop-down list, select "Global DB".
Click "OK".

Add new block

s Gobe]
(@ cobeivs] |

DB
4F LUPS1600_UP51600 [FB164]

Figure 7-25
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8. Open the global DB created in step 6 (UPS_Global). Add a new tag with data type as
"LUPS1600_typeUPS1600Data".

Devices

Project_LUPS1600 » PLC_2 [CPU 315-2 PN/DP] » Program k

¥ | ] Project_LUPS1600
B’ Add new device
ﬁ'g'h Devices & networks
» [l PLC_1 [CPU 1214C DC/DC/RKy]
~ [1j PLC_2 [CPU 315-2 PN/DP]
[h' Device configuration
4] online & diagnostics
= |5 Program blocks
I Add new block
| CYC_INTS [OB35]
3 Main [OB1]
@l LUPS1600_UPS1600_DB [DB1]
[ @ uPs_Global [DB2] |
» (%] LUPS1600_FB

Figure 7-26

2| == 6, -2 E D"_:" Keepactualvalues [gg Snapshot ™5

UPS_Global
E MName

| @ v stic
2 @l = »r ups

9. In the network area of OB35,

Data type Offset

[peUFRS1600Data |

Real
S5Time
String
Struct

]

Time
Time_Of _Day
Word

"LUPS1600_typeUPS1600.f +

Note

OBs are called cyclically and in numerical order. Observe this when calling the
communication blocks in an operation block. This ensures that you are reading the current
data of the power supply.

— For the parameter addrIn, enter the PROFINET diagnostic address of the UPS1600
module (2042).

— For the parameter cyclicIOAddr, enter the start address of the UPS1600 module

(68).

— Connect the parameter upsReadyForReset with a tag of your project that you use to
bring the plant into a condition in which it can be shut down.

— Connect the parameter upsExecuteReset with a tag of your project that you use to
switch off the UPS when the plant is in a condition in which it can be shut down.

68
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— Connect the parameter data with Global DB UPS_Global.

%OB1
"LUPS1600_
UFS1600_DE"
WEB1ES
"LUPS1600_UPs1&e00"
EN ENO

2042 — addrin upsReadyForke  #MO.5

68 — cyclicloaddr set —i"Tag_2"

W02 ypsExecuteRes

"Tag_3" — et

PHDE2.DEX0.0

"UPS_Global".ups data

Figure 7-27

Note
addrIn and cyclicIOAddr parameters

To know the addrIn and cyclicIOAddr parameter values of the UPS1600 module, refer to

Interfaces of the function block FB165 (Page 58).
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7.2.5.2 Procedure when using an S7-1200/1500

Overview
Hardware used:
* CPU 1214C DCIDCIRly
* SITOP UPS1600 24 V/20 A
The procedure for other SIMATIC S7-1200/1500 controllers is identical.

Note

Please ensure that all requirements for the integration of the FB are met. The requirements
are described in the Prerequisites (Page 55).

Inserting blocks from the library into the program

Follow the procedure to insert the blocks and the associated data blocks into a STEP 7 V16
project:

1. Open the required project in "Project view".

2. In the "Libraries" tab, under "Global libraries", open the library "LUPS1600".

The procedure for opening the library is described in the Content of the library in STEP 7 V16
(Page 55).
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3. Inthe library, select "Types > LUPS1600 > STEP7 > S7-1200/500 > FB > LUPS1600_UPS1600".

Libraries
Options a
. =1
€] Libraryview £ d g_
i & =
> Project library 2
v : Global libraries
= ) b [
FdHaux E=EMIY
» LI Buttons-and-Switches §'
» LUl Long Functions 5
» LLI Monitoring-and-control-abjects g-
» LUl Documentation templates z
~ [l LUPS1600
~ [5] Types ;
¥ [t LUPS1600 N
w [z STEF7 =
= =
b iz 57-300/400 gl
¥ [Lz §7-1200/1500 L
~ [l FB s
| » " LUPS1600_UPS1600 | =
» [z UDT =
» [ wince =
- . =
» L Master copies =
» [ L8 common data
»  Languages & resources =
=

Figure 7-28

4. Drag-and-drop "LUPS1600_UPS1600" into the "Program blocks" folder in the "Project tree".

Project tree m 4
Devices

e
GiQQ
gy Devices & networks
~ [i§ PLC_1 [CPU 1214C DC/...
[IY pevice configuration
"%/ Online & diagnostics

;g Program blocks I

4

» l——i-ﬁ Technology objects

» External source files
» [ PLCtags

v [ PLC data types

» [55 Watch and force tab...
» & Online backups

»

Ea
73 Traces

Figure 7-29
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Note

Even "LUPS1600_typeUPS1600Data" will be automatically copied to the "PLC data types"

folder in the "Project tree".

Project tree

Devices

~ | ] Project_LUPS1600
EF Add new device
gy Devices & networks

Y pevice configuration
%] online & diagnostics
» rﬂ. Prograrm blocks
» [ Technology objects
» External source files
» L4 FLCtags
« [ PLC data types
ﬁ Add new data type
=[] LUPS1600
- [iz] STEF?

w [&] UDT

~ [ PLC_1 [CPU 1214C DGDGRIY]

 [&:] 57-1200/1500

m 4

2]

| ] LUPS1600_typelUPS1600Data
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Calling the function block

Follow the procedure to call the FB within an organization block (OB). In this description,
FB165 is called within OB30:

1. Inthe "Project tree", open the "Program blocks" in the controller.

2. Create an OB with the name "Cyclic interrupt [OB30]" and open it. This displays an empty
network.

3. Drag-and-drop "LUPS1600_UPS1600 [FB165]" from the "Program blocks" folder to the empty
network of OB30. The "Call options" dialog box opens.

Project tree m 4
Devices

als
ras

|§|: W e, EF

Cyclic interrupt

| Project_UPS1600 A
ﬁ.ﬁ\dd new device I AF - =0— —
o Devices & networks -
~ [ PLC_1 [CPU 1274C DG/DCIRIY] b Block title: ...
[IY pevice configuration =™ Network1: ..

%] Online & diagnostics
~ |5 Frogram blocks

Comiment

B Add new block J/
3 Cyclic interrupt [OB30] |
48 Main [0B1] v

| %8 LuPs1600_UPS1600 [FB1...|/ |

4. Keep the default settings of the dialog box and click "OK".

5. Double click on "Add new block" to add a new DB. The "Add new block" window opens.
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6. In the "Add new block" window,
Select "Data block".

Enter a name as desired (UPS_Global).
In the "Type:" drop-down list, select "LUPS1600_typeUPS1600Data".

Click "OK".

Add iew block

4 LUPS1600_UPS1600 [FB164]
48 RDREC_SFB [SFB52]
4 WRREC_SFB [SFBS3]

Data block

Figure 7-30
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7.2 Application of the function blocks under STEP 7 Professional V16

7. Right click on the global DB created in step 5 (UPS_Global) and go to "Properties > General >
Attributes".

8. In the network area of OB30 for FB165,

For the parameter addrIn, enter the hardware ID of DC-UPS-20A_1~Head of the
UPS1600 (281).

For the parameter cyclicIOAddr enter the hardware ID of DC-UPS-
20A_1~Data_submodule of the UPS1600 (282).

Connect the parameter upsReadyForReset with a tag of your project that you use to
bring your plant into a condition in which it can be shut down.

Connect the parameter upsExecuteReset with a tag of your project that you use to
switch off the UPS when the plant is in a condition in which it can be shut down.

Connect the parameter data with the global DB created in step 6, (UPS_Global).

WOEN
"LIUFS1600_
UFS1600_DB"
%FBEI1ES
"LUPS1600_UPS1600"
EM ENO

2871 upsReadyForhe kRO
"DC-UPS-204,_ set — "Tag_4"

T-Head" — addrin

282

"DC-UPS-204,_

10-Doata_
submodule” — qolicioaddr

WA0S UpsExecuteRes
"Tag_3"— et

4DE2
"UPS_Glabal" — data

Figure 7-31

Further information about the block parameters, refer to Interfaces of the function block
FB165 (Page 58).

Note

addrIn and cyclicIOAddr parameters

To know the addrIn and cyclicIOAddr parameter values of your UPS1600 module, refer
to Interfaces of the function FB165 (Page 58).
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8.1 Application of the faceplates in WinCC flexible 2008

8.1.1 Prerequisites

Requirements
The following requirements must be met to use the faceplates in WinCC flexible 2008 SP5:

* The GSD file of the SITOP UPS1600 is installed in SIMATIC STEP 7 V5.6 and UPS is
configured as PROFINET node in the HW configuration of the CPU.

e S7 communication between SITOP UPS1600 and CPU is already configured.

e All the program blocks from the library UPS1600 V3_1 STEP 7 V5_6 are integrated into the
STEP 7 application program and executable.

e The library 'UPS1600 V3_1 library WinCC Flexible 2008' for WinCC flexible 2008 SP5 is
available on your computer.

Supported control panels
The faceplates are supported for the following control panels:
e TP27010"
e OP270 10"
* MP270 10" Touch
* MP277 8" Touch/Key
e MP277 10" Touch/Key
* MP377 Touch/Key
*  WinCC flexible Runtime 2008 SP5

Supported languages
The faceplates support the following languages:
e English (USA)
e German (Germany)

¢ Chinese (PR China)
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8.1.2 Library for WinCC flexible

Library for WinCC flexible

The library 'UPS1600 V3_1 library WinCC flexible 2008' for WinCC flexible 2008 SP5 comprises
of the following objects:

Table 8- 1
Name Type Description
UPS1600 V3_1 HMI Tag table Tag folder A tag folder with all the required tags
Faceplate_UPS1600 V3_1 Faceplate Contains the faceplate
'Faceplate_UPS1600 V3 1"
HMI Alarm views Message window Contains two message windows for
displaying diagnostic messages of the
UPS1600
UPS1600_Data Structure Contains a group of structure elements
required for UPS1600 faceplate
8.1.3 Integrating the faceplates
Overview
The following sections describe all the steps required to integrate a faceplate into a WinCC
flexible 2008 SP5 project.
Hardware used:
* MP277 8" Touch
An overview of the supported HMI control panels is available in the Prerequisites (Page 77).
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Opening the library
The following procedure describes how to open the library in WinCC flexible 2008 SP5:
1. Open the WinCC flexible project into which you want to insert the faceplate.

2. In the "Tools" window, select the "Library" tab and click on the highlighted icon to open the
library. The "Open global library" dialog box opens.

@ x
L " :

Simple Objects
Enhanced Ohjects
Graphics

Library

Mo libraries opened,

Usethecontextmenu, thetoolbarardrop
objects hereto create aropen libraries.

. Drop any objecthere to delete
ﬂ it.

Figure 8-1
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3. Click the "Look in:" drop-down list and browse to the stored location of the library "SITOP-
UPS1600_Library_STEP7-V5_V3-1 > UPS1600 V3-1 library WinCC flexible 2008" on your
computer.

.,

My Libraties

H

Stand-alone

[ U 1600

Loak in: IE UPS1600°%31 libramy WinCC flexible 2008

31 libran WinCC Flesible 21

Flemxcsm-

File: narme:

ﬂ File byvpe:

UPS1600%3_1 library */inCC Flexible 2008, wIf -

WiInCC flexible libraries]” wif]

Open | | Cancel

Figure 8-2

4. Select "UPS1600 V3 _1 library WinCC flexible 2008.wIf" and click "Open".

This imports the library into your project.
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Inserting faceplates into a project

The following procedure describes how to integrate the faceplate from the library into an
existing WinCC flexible project:

1. Open the required WinCC flexible project.

2.

In the "Project” window, open the screen into which you want to insert the faceplate
(Screen_1).

@ (x

luas Project
SIMATIC HMI-Station(1)[MP 277 8"
24 Screens

—a Add Screen

=g Lommunication
-2 Tags

ca 3
<<<<< o0 Connections

(=4 Alarm Management
<<<<< B4 Analog Alarms

""" A Dizcrete Alarms
-5z Settings

4 Recipes

Hizstorical Data

i Scripts

H- 3 Reports

i Text and Graphics Lists

é Runtime User Administration
-+ Device Settings

(=43 Language Settings

----- @ Project Languages

----- HE Graphics —
- = Project Texts

- Dictionaries

-

m

Figure 8-3

3. In the "Tools" window, under the "Library" tab, select the faceplate element

"Faceplate_UPS1600 V3 1"
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4. Drag-and-drop "Faceplate_UPS1600_V3_1"into the opened screen.

g table Faceplate_UPS1600_V3_1 | [] Template

IR R
E S aa B B e B e B e B B G B G o

" SIEMENS

Information

Alarms

000000000000
Q00000000000

Device name:

Simple Ohjects

Enhanced Objects

Graphics

Library

HW revision:

SW revision:

L A R =i e

Figure 8-4

@ Praject library
w0 UPS1600%3_1 librany 'winCE Flesible 2008

Wiews W3_1 HM.. Data
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5. In the "Project" window, select "Screens” and open "Template”.

@ x

les Project
Elpear SIMATIC HHI-Station[1][MP 277 8"
= & Screens

3 &dd Screen

E I Template .

----- [ Screen_1
=5 Communication
..... <= Tags

----- HSE Connections

=4 Alarm Management
----- B4 Analog Alarms
<<<<< B4 Discrete Alarms
-5z Settings

H-g Recipes

H- Historical Data
H-<437 Scripts

H-- 1 Reports
|
t
t

m

42 Tewt and Graphics Lists

§ Runtime User Administration
i Device Settings

=4y Language Settings

----- @ Project Languages

----- HE Graphics T
- = Project Texts

- Dictionaries -

Figure 8-5

6. In the "Tools" window, select the "HMI Alarm views" element of the library.
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7. Drag-and-drop "HMI Alarm views" into the template. Two message windows are inserted.

Itag table

Faceplate UPS1600_V3_1 <> x
Simple Objects

Enhanced Objects

Graphics

Library

@ Project library
([ UPS1B00%3_1 fibrary WinCC Flesible 2008

UPS1600 UPS1e00_
W3_1 HM.. Data

Faceplate |[HMI Alarm|
e

Figure 8-6

8. Select "Alarmview_UPS_Pending" alarm window, right-click on the "Properties" and select
"Properties > Display > Enable "ACK" button". Repeat the same procedure for enabling "ACK"

button in "Alarmview_UPS_History" alarm window.

9. In the "Project" window, select "Communication > Tags".
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10.In the "Tools" window, select the "UPS1600 V3_1 HMI tag table" library element.

kL2

Simple Objects

Enhanced Ohjects

Graphics

Library

@ Praject library

['[1] UPS1600%3_1 library WinCC Flexible 2008

i —EH E

i
i

Faceplate_ HMI Alarm| UPS1600

UPS1e00_
UPS1e00.. \Views M3 _1 HM...

Figure 8-7

Data

11.Drag-and-drop "UPS1600 V3_1 HMI tag table" into the "Tags" folder.

s Proj
E-9F Screens
-0 Add Screen

(-5 Communication

----- .S' Connections

(=g Alam Management
N B4 Analog Alams
----- BR Discrete Alarms
| [H-Y Settings

i-2) Recipes

-4 Historical Data

- Text and Graphics Lists

: e Runtime User Administration
— Device Settings

B4 Language Settings

i@ Project Languages

~ & Graphics

= Project Texts

@ Dictionaries

-5 Structures

(- Version Management

Figure 8-8

EI; SIMATIC HMI Station(1¥MP 277 10” Touch)
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Application of the faceplates

8.1 Application of the faceplates in WinCC flexible 2008

12.0pen the tag table "UPS1600 V3_1 HMI tag table", for the "UPS_Data" tag,
— Inthe "Connection” column, select the required connection. (The connection name
must be identical to the name of the connection created during configuring
connection to the controller.)

— Assign the global DB "UPS_Global" number to the tag (DB15).

EEmEEmETTy

IName Symbol Address Arrayelements |Ad
£ alarmpending <Undefined > <No address> 1 1s
= alarmhistory <Undefined = <No address> 1 1s
£ UPsData <Undefined> ~|psisDBWO  ~v|1 50|

Range |DB ~
o5 [15 |
Figure 8-9

13.In the tag table, select the tag "alarmhistory". Check the properties of the tag where in the

"ShowAlarmWindow" function is inserted and its variable "Object name" is assigned to the
tag "Alarmview_UPS_History".

If the "Properties” window does not open then right click on the tag and go to "Properties".

[ Sereen_1 | [] Template

| <=UPS1600 V2_1 HMI tag table

tion |Address

<Internal tag> j <o address =

Face|:|IaI:e_intern_alarmview_buléfer < Indefin

Faceplake_inkern_alarmyviess_pending | <Internal kag= <Mo address = < dndefin
E  Ups_Data 37 conneckion_1 DE 1 CEW O < Indefin
B ol EE Function List
P Properties
4 E’ventrs. ; ‘B ShowalarmWindow
Change value 1 = Prss T O :
® High limit Object name ﬂm%wﬂmﬁr}b
m Low limit Display mode Togale
2 I <MNo functionz |
Figure 8-10

Similarly, check the properties of the tag "alarmpending" where in the

"ShowAlarmWindow" function is inserted and its variable "Object name" is assigned to the
tag "Alarmview_UPS_Pending".

If the "ShowAlarmWindow" function is not inserted for these two tags, refer to the section
Adding "ShowAlarmWindow" function to the tags described below.
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14.Select the faceplate inserted in step 4 (Screen_1) and go to "Properties > Dynamic Interface".

15.Under the "Data" section, for the "UPS_Data" property assign the "UPS_Data" tag created in
step 11.

W Properties
¥ Dynamic Interface
m Layout
m Misc

® General

alarmhistor: - 1is
b Animations Faceplate_Intern_alarmview_buffer Yy _]
Faceplate_Intern_alarmview_pending |alarmpending :I is

isibility

Data

UPS_Data |UPS_Data | [s00ms
~

I Station(1)
ication

5
++[|UPS1600 V3_0 HMI tag tab

e a00(1)

- |y 416-3PNj0P

< ils7 Program(3)

] Symbols v

Figure 8-11

16.Under the "Visibility" section, for the "Faceplate_intern_alarmview_buffer" property insert
the "alarmhistory" tag from the "UPS1600 V3_1 HMI tag table" tag table.

W Properties 1l 2
B Dynamic Interface i

M layoub WVigibility o

m Misc s

m General [ 2 fa
i alarmhistor: > 1s e

P Animations Faceplate_Intern_alarmview_buffer ¥ J | :

b Project A

Faceplate_Intern_alarmview_pending || SIMATIC HMI Statiol <Undefined >

“5 Communication
=-+= Tags
“egm UPS160(

alarmpending

ﬁtl ml

Data

UPS_Data |2 UPS Test
- SIMATIC 400(1)
=-[§ cru416-3F
=-{57] 57 Progr
@ Sym o
=
>

< < > |

> T V=l

Figure 8-12

Similarly, for the "Faceplate_intern_alarmview_pending" property insert the
"alarmpending" tag from the "UPS1600 V3_1 HMI tag table" tag table.

Note
Connection in the UPS1600 V3_1 HMI tag table

A default connection is always created automatically when a project is created. Delete the
default connection if you have created another connection for your project.
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8.1 Application of the faceplates in WinCC flexible 2008

Adding "ShowAlarmWindow" function to the tags

The following procedure describes how to add the "ShowAlarmWindow" function to
"alarmpending" and "alarmhistory" tags in the "UPS1600 V3_1 HMI tag table" tag table:

—_

. Select the "alarmhistory" tag. A new window opens.
. Go to "Events > Change value".

2
3. Click on "<No function>".
4

. In the drop-down list select "System functions > Alarms > ShowAlarmWindow".

[ [ o [ omieso I

[Name Symbol '|Addres: |Array elements m
% alarmpending <Undefined> <No address> 1 is
g alarmhistory I ]<Undeﬁned> :J <No address> 1 1s
= |UPS_Data <Undefined> DB 15 DBW 0 1 500 ms
& Generdl == Function List
} Properties
w E’V&nt: : 1 <MNo function> i
Change value
® High Iﬁnit =) System functions A
SR . g :JJI system functions
- Alarms
‘... ClearAlarmBuffer
- ClearAlarmBufferProtoolLegacy
SetAlarmReportMode
ShowAlarmWindow
i ShowSystemAlarm
(- Calculation v
Figure 8-13

5. For the "Object name" variable click on "<No value>".

6. In the drop-down list select "Alarmview_UPS_History".

Follow the same procedure for the "alarmpending” tag, add "ShowAlarmWindow" function

and select "Alarmview_UPS_Pending" for the "Object name" variable.

Displaying the PROFINET diagnostic messages

To display the PROFINET diagnostic messages of UPS1600 within the faceplate, the respective

WinCC flexible project must already be configured.

Information on the display and configuration of diagnostic messages in WinCC flexible is

available in the entry ID 22319131
(https:/lsupport.industry.siemens.com/cs/ww/en/view/22319131).

Further notes regarding the PROFINET diagnostic messages of the SITOP UPS1600 are

available in the chapter 4 of the SITOP UPS1600 User Manual
(https:/lsupport.industry.siemens.com/cs/ww/en/view/84977415).
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8.2 Application of screen windows in WinCC V7.4
8.2.1 Prerequisites
Requirements

The following requirements must be met to use the screen windows in WinCC V7.4:

* The GSD file of the SITOP UPS1600 is installed in SIMATIC STEP 7 V5.6 and the UPS is
configured as PROFINET node in the HW configuration of the CPU.

e S7 communication between the SITOP UPS1600 and CPU is already configured.

e All program blocks from the library UPS1600 V3_1 STEP7 V5_6 are integrated into STEP 7
application program and executable.

e The library UPS1600 V3-1 library WinCC V7.4 is available on your computer.

* Existing WinCC OS (PC station) with already configured connection and active
communication.

PC Station

The screen windows are supported for the following PC Station:
e WinCCV7.4 Runtime

Supported languages
The screen windows support the following languages:
e English (USA)
e German (Germany)
e Chinese (PR China)
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8.2 Application of screen windows in WinCC V7.4

8.2.2 Library for WinCC V7.4

Library for WinCC V7.4

The library UPS1600 V3-1 library WinCC V7.4 for WinCC V7.4 comprises the following file

folders:

Table 8- 2

Name Type Description

HMI Tag table (WinCC V7.4) Tags File for tag import

HMI Screens (WinCC V7.4) Screens Comprises screen 'UPS1600 V3 _1.pdl'

HMI Tag table (WinCC V7.4)

This folder contains the file UPS1600_HMIUDT.txt. This text file comprises all the tags and
structure required for the functioning of UPS1600 screens.

HMI Screens (WinCC V7.4)

This folder contains the screen UPS1600_V3_1.pdl.
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8.2 Application of screen windows in WinCC V7.4

8.2.3 Integrating the screen windows

Overview
Target system used:

e WinCC V7.4 Runtime

Inserting the project screens

The following procedure describes how to insert the HMI screen from the library into the
project directory of your WinCC project:

1. Open "Windows Explorer" in your computer machine and navigate to the "GraCS" folder in
your project directory. Here, path to the folder is: "C:\Program
Files(x86)\SIEMENS\STEP7\S7Proj\Ups1600\wincproj\OS(1)\GraCS".

2. Open another instance of "Windows Explorer" in your computer machine and navigate to
the stored location of the "SITOP-UPS1600_Library STEP7-V5 V3-1"library folder.

3. In the library folder, open "UPS1600 V3-1 library WinCC V7.4".
4. Copy the "UPS1600 V3_1.pdl" screen element from the library and paste it into the "GraCS"

folder.
i —— g
(= ][@]=]
@le <« UPSL.. » HMIScreens (WinCC 7.4) ~ | 3| [ Search HMt Screens (winCC v7.4) P
Organize v Include in library + Share with » MNew folder = ~ O vif:é}
e Favorites = Mame Date modified Type
‘ Desktop ‘ 3 | 4] UPS1600_W3_1.pdl 51772021 2:03 PR PDL Document
& Downloads
=l Recent Places
L,_a_v.l..lbrarles [ = ‘ v
(oo =]
@vv’ o« wincproj b OS(1) » GraCs - | +y H Search GraCs p|
Organize = Include in library = Share with = MNew folder =~ 0l @
b Exiiites & Mame Date modified Type
B Desktop ‘i’ |L UPS1600_V3_1.pdl 5762021 9:24 AM POL Document |
& Downloads | WIDesigns.xml 5720211004 PR XMAL File
£l Recent Places
o4 Libraries - |3 1 r
Figure 8-14
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8.2 Application of screen windows in WinCC V7.4

Importing tags

The following procedure describes how to import the HMI tag table file from the library folder

into your WinCC project:

1. Open your WinCC project in WinCC Explorer.

2. Open the "Tag Management" element. The "Tag Management — WinCC Configuration

Studio" window opens.

% WinCC Explorer - C:\Program Files Ga8NSIEMENSASTEP TysTproj\Project ‘i, [ = || & |[s23a]

File Edit ‘iew Tools Help
Jolmy KR EE gl ?
= g% O3(1) Marne Type
""" CJ Computer CH Computer Computer

|_ ..... W Tag Management |

----- /A Graphics Designer

----- = Blarm Logging

----- 101 Tag Logging

----- a Report Designer

..... 1 Global Script

FEF Text Library

----- 5 Text Distributor

----- iﬁ User &dministrator
----- 5 " Cross-Reference

----- _i’ Server data

----- @ Redundancy

J_U User &rchive

':) Time synchronization
----- A3 Horn

----- ﬁ‘ Picture Tree Manager
g Lifebeat Monitoring

----- #,, OS Project Editor

----- J _l Component List Editor

E% SFC

..... P Web Navigator

m Tag Management Tag Management

A Graphics Designer Editor
A Alarm Logging Editor
J11Tag Logging Editor
ﬁ Report Designer Editor
1. Global Script Editar
B Text Library Editor
54 Text Distributor Editor
iﬁ User &dministrator Editor
f‘;Cross-Reference Editor
5_. Server data Editor
! Redundancy Editor
J_U User Archive Editor

':-)Time synchronization Editar
i Homn Editor
T Picture Tree hanager Editor
Q;,:ALifebeat Monitaring Editor
#, 05 Project Editar Editar
10 Component List Editor Editaor
=5 SFC Editar
P web Mavigator Editor

< | 1 | 3

Press F1for Helo.
Figure 8-15
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3. In the "Tag Management" window, select "Structure tags".

mn Tag Management - WinCC Configurz
File Edit View Help

Tag Management «

@.‘”l Tag Management

-5 Internal tags

i SIMATIC 57 Protocol Suite
-
T3 @AssetControlStruct

-+t @Maintenance

[g? Alarm logging
jjj Tag Logging

@t 3o -

Ready | NUM  Scrol \

Figure 8-16

4. In the menu bar, select "Edit > Import". The "Import" window opens.

5. Browse to the stored location of "SITOP-UPS1600_Library STEP7-V5_V3-1"library folder in
your machine and open "UPS1600 V3-1 library WinCC V7.4 > HMI Tag table (WinCC V7.4)".
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8.2 Application of screen windows in WinCC V7.4

6. Select "UPS1600_HMIUDT".

®-| |« UPS160.. » HMITag table (WinCC V7.4) - | 43 || search M Tag tavie (WincC... P |

Organize v New folder =~ 0 @

¢ Favorites Marme Date modified Type o

B Desktop IU UPS1600_HMIUDT 71042017 12:15 &4 Text Document I
Li. Downloads
&l Recent Places

[ Libraries
Documents
J’ Music
[E] Pictures

B videos

"M Camniter ~ | ) ! | 5

File narme: JPS1600_HMILDT - [Unicodetefc(*.bct) ']

[ Import ] [ Cancel l

Figure 8-17

7. Click "Import". "UPS1600_Data" structure tag element appears under "Structure tags" in "Tag
Management" window.

File Edit View Help

Tag Management «
E]!!! Tag Managerment

ﬁ Internal tags

- @ I SIMATIC $7 Protocol Suite

B% Structure tags

7% @AssetCantrolStruct
DMaintenance

Figure 8-18

8. Close the window.
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Configuring screen windows

8.2 Application of screen windows in WinCC V7.4

The following procedure describes how to configure a screen window:

1. In the WIinCC project, select "Graphics Designer".

2. On its right window pane, right click on the empty space and select "New picture" option to

add a new pdl file.

45 WinCC Explorer - C:\Program Files (8N SIEMENSASTEP TsTpraj\Praject_\wincprajyO... | =

File Edit ‘iew Tools Help

dm | £ = A2

B g 0S(1)

,,,,, g Computer

..... |II Tag Management

| vvvvv ,‘\ Graphics Designer |
vvvvv J Alarm Logging

..... a Repor‘t Designer
----- _] e Global Script
Text Library
5 Text Distributor
----- i}i User Administrator

----- 5 g Cross-Reference

o

----- i Server data

----- @ Redundancy

----- _U_] User &rchive

----- ';) Time synchronization
----- ) Horn

----- “,L? Picture Tree Manager
J_:; Lifebeat Monitaring

----- K, OS Project Editor

----- _I _1 Component List Editor
E:% SFC

----- " Wifeb Navigator

Mame 3
A @1001.pDL w
A @@ConfigTypica HREn

A @@Maintenancel I Mews picture

f\ @AlarmActive PD Graphic OLL

/‘\ @AlarmactiveOp.
A @A&larmEmergena
A @AlarmEmergeng
f\ @AlarmGone POL
A @alarmGoneOp.F
A @AlarmHidden.PDL
A @2&larmHiddenOp.PDL

A @AlarmHiding.PDL

A @alarmHidingOp.PDL

f’\ @Alarmlournal PDL

A @alarmLocked.PDL

A @AlarmNew.PDL

A @2larmNewOp.PDL

A @AlarmOld.POL

A @alarm0ldOp.POL

)‘\ @alarmOneline PDL

A @AlarmOperation.PDL

fb\ @AlarmProcess.POL

A @alarmQuitPDL J

. -
< | 1 \ N

Select ActiveX Control
Show information column

Edit Favorites order

Properties

OS(INGraphics Designery,

Figure 8-19

572 object(s)

3. Rename the pdl created in step 2 as required (UPS_ScreenWindow) and open it. The
"Graphics Designer" window opens.

4. In the "Standard" window of the Graphics Designer go to "Smart Objects" folder and select
"Picture Window".
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5. Click on the "UPS_ScreenWindow.pdl" screen area to insert the "Picture Window".

pe

A Graphics Designer - UPS_ScreenWindow.pd)
File Edit View Arrange Tools Window Help

PO REEHE P L @ e Bl &1 % @ QQ 100% ~
: D N A0 TN N = WO 0 e I - |

A1

' UPS_ScreenWindow.pdl X v | Standard
............................................. - (s Circular &rc
PICTURE WINDOW L .. Rectangle
o 70 Rounded Rectangle
| P e A Static Text

i —o]" Conhector
< || @) Smart Objects
. 2% Application Window
008 Caontrol
| g OLE bject
‘ [0 If0 Field
ug Bar
- 24] Graphic Object
..... _.é Status Display

- Text List
............................................. 5 3; Multiple row text
< 1 r . H Combabox
Figure 8-20

6. Select the added screen window and go to "Properties > Miscellaneous".

7. For the "Picture Name" attribute assign "UPS1600_V3_1.pdI" and for the "Tag Prefix" attribute
assign the tag "UPS_Global" created during importing the HMI tag table (refer to STEP 7 in
Configuring Screen windows procedure). If your structure tag name is 'StructureTag' then
add a " at the end of your tag name, that is 'StructureTag.' (<Structure tag name>.). Here,

"UPS_Global.".
Object Properties
| Properties | Events|
lecture Window | Attribute Static Dynamic  Update.,  Indir..
[~ Geornetry Adapt Picture Mo
—Miscellaneous |p;ct,re scaling mode Unifarm
Picture Name UPS1A00 %3 _1.pdl g [ |
Picture Offset X 0 ¢ O
Picture Offset ¥ 0 9 F
Scroll Bar Position X 0 v O
Scroll Bar Position 0 ¢ O
Scaling Factor 100 ¢ |
Taq Prefix UPS _Global, Q |
Server Prefix o | 4

Figure 8-21
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8.2 Application of screen windows in WinCC V7.4

Displaying the PROFINET diagnostic messages

In order to display the PROFINET diagnostic messages of the SITOP UPS1600 within the
screen windows, the respective WinCC project must already be configured for the display of
PROFINET diagnostic messages.

Information on the display and configuration of diagnostic messages in WinCC is available
under the entry ID 23730649
(https://support.industry.siemens.com/cs/ww/en/view/23730649).

Further notes regarding the PROFINET diagnostic messages of the SITOP UPS1600 are
available in the chapter 4 of the SITOP UPS1600 User Manual
(https:/Ilsupport.industry.siemens.com/cs/ww/en/view/84977415).

8.2.4 Application of screen windows in WinCC V7.5

8.2.4.1 Overview

To work with the library in WinCC V7.5 follow the similar process as mentioned in Application
of screen windows in WinCC V7.4 (Page 89), except opening the library UPS1600 V3-1 library
WinCC V7.5 in place of UPS1600 V3-1 library WinCC V7.4.
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8.3 Application of faceplates in WinCC Comfort/Advanced V16

8.3 Application of faceplates in WinCC Comfort/Advanced V16

8.3.1 Prerequisites

Requirements

The following requirements must be met to use the faceplates in WinCC Comfort/Advanced
V16 and WinCC Comfort/Advanced V17:

e The HSP for the SITOP UPS1600 is installed in STEP 7 V16.

e S7 communication between SITOP UPS1600 and SIMATIC S7 controller is already
configured.

* Program blocks for STEP 7 V16 from LUPS1600 are integrated into the application
program and executable.

e LUPS1600 is available on your computer.

Supported control panels
The faceplates are supported for the following control panels:
* TP700 Comfort/KP700 Comfort
* TP900 Comfort/KP900 Comfort
* TP1200 Comfort/KP1200 Comfort
* TP1500 Comfort/KP1500 Comfort
* TP1900 Comfort
* TP2200 Comfort
e MP277 8" Touch/MP277 8" Key
e MP277 10" Touch/MP277 10" Key
e MP377 Touch/Key
e WinCCRT Advanced V16

Supported languages
The faceplates support the following languages:
e English (USA)
e German (Germany)
e Chinese (PR China)
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8.3.2 Library for WinCC Comfort/Advanced

Library for WinCC Comfort/Advanced
The following objects are part of LUPS1600 for WinCC Comfort/Advanced:

Name Type Description

Comfort/Advanced Faceplate from Types folder Comprises of
"LUPS1600_FpS712001500RTAdV" faceplate
and "LUPS1600_type300400RTAdV" HMI
ubDT

TagTablesRTAdv Tag folder from Master copies Comprises
LUPS1600_TagTableS7300400RTAdv and
LUPS1600_TagTableS712001500RTAdv

AlarmWindows Alarm views from Master copies | Comprises ‘Alarm windows' screen that has
two message windows to display the
PROFINET diagnostic messages of the
UPS1600.

8.3.3 Integrating the faceplates

Overview
Hardware used:
¢ TP900 Comfort

An overview of the supported HMI control panels is available in the Precondition (Page 98).

Opening the library in WinCC V16

The procedure for opening the library in WinCC Professional V16 is explained in the Content
of the library for STEP 7 V16 (Page 55).

Inserting faceplates into a project

The following procedure describes how to integrate the faceplates from LUPS1600 into an
existing WinCC project:

1. Open the required project in "Project view".

2. In the "Project tree", open the "Screens" folder.
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3. Double click on "Add new screen” to add a new screen into your project.

Project tree

Devices

v | Project_LUPS1600 |~
B Add new device ]
g Devices & networks

» |1 PLC_1 [CPU 1214C DC/DC/RIY]
» (1§ PLC_2 [CPU 315-2 PN/DP]
» [ PLC_3 [CPU 416-3 PN/DP]
~ [ HMI_1 [TP300 Comfort]

ﬂ'f Device configuration

'] online & diagnostics

1 Runtime settings

v E__| Screens

|ﬁ Add new screen |

Figure 8-22

Open the new screen (Screen_1).

Project_LUPS1600 » HM_1 [TP900 Comfort]

Devices
~]B I USA:

~ |7 Project_LUPS1600
I’ Add new device
ﬁg-b Devices & networks
» [ PLC_1 [CPU 1214C DC/DC/RKy]
» [ PLC_2 [CPU 315-2 PN/DP]
» [ﬂ PLC_3 [CPU 416-3 PN/DP]
~ [ HMI_1 [TP900 Comfort]
[h’ Device configuration
%] Online & diagnostics
¥ Runtime settings

> r_|j screens
“L‘ Add new screen
|k ] Screen_1 |

Figure 8-23
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4. Inthe "Libraries" window, select "Global libraries > LUPS1600 > Types > LUPS1600 > WinCC >
Comfort/Advanced > S7-1200/1500 > LUPS1600_FpS712001500RTAdV".

Libraries

Options
€| Library view £l O
? | Project library

531521@1”

+ : Global libraries
0 I S e mE

Name

» Ll Buttons-and-Switches

» LI Long Functions

» Ll Monitoring-and-control-objects

saplmqn E”

» LIl Documentation templates
- ||| LUPS1600
¥ [ 5] Types
- [i:] LUPS1600
b [&:] STEF7
- [i:] WinCC
|tz ComfortiAdvanced
» [z 57-300/400
¥ |t:z| 57-1200/1500
| » [ LUPS1600_FpS712001500RTAdv

» |t:z| Professional

| surppy |

I
|

T

<

b || Master copies
» 4{ Common data
» Languages & resources

Figure 8-24

5. Drag-and-drop "LUPS1600 FpS712001500RTAdV" into the opened screen in step 3.
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Creating a connection to the data block for global data exchange

102

The following procedure describes how to create a connection to the data block for global
data exchange:

1. Inthe "Libraries" window, select "Global libraries > LUPS1600 > Master copies > LUPS1600 >

WinCC > Comfort/Advanced > TagTablesRTAdv > LUPS1600_TagTableS712001500RTAdV".

Libraries

Options

& Libraryview £ 0

syse] kiit

* Project library

w i Global libraries

» Ll Buttons-and-Switches
» LI Long Functions
» LL| Monitaring-and-contral-abjects
» LUl Documentation templates
||| LUPS1600
» 3] Types
~ [ Master copies
w [&] LUPS1600
» [%:] STEP7
5] Wincc
* iz Comfortfadvanced
» [
¥ |tz TagTablesRTAdw
Zg LUPS1600_TagTableS7300400RTAdy

T Alarmwindows
i

D =K

sayeiqr] E”

| 5 LUPS1600_TagTable5712001500/TAdy |

» iz Professional
[} common data

4
¥ Languages & resources

Note
S$7-300/400 PLC

For S7-300/400 PLCs, select "LUPS1600_TagTableS7300400RTAdV" instead of

"LUPS1600_TagTableS712001500RTAdV".
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2. Drag-and-drop "LUPS1600_TagTableS712001500RTAdV" into the "HMI tags" folder in the
"Project tree".

Project tree m 4
Devices

S Ell=

v | ] Project_LUPS1600 [~

""‘ Add new device
gy Devices & networks
» ([ PLC_1 [CPU 1214C DC/DC/RIY]
» [ PLC_2 [CPU 315-2 PN/DP]
» ([ PLC_3 [CPU 416-3 PN/DF]
= [ HMI_1 [TP900 Comfort]
[IY pevice configuration
[%| online & diagnostics
1 Runtime settings

» [ Screens
J r_[]'j Screen management

___________ L_P__'_é HMi tags |

%24 Connections |-
4 HMI alarms

o Recipes

Figure 8-25

3. Open "LUPS1600_TagTableS712001500RTAdV" in the "HMI tags" folder.
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4. For the "UPS_Data" tag, set the global DB (UPS_Global) created in Procedure when using an
S7-1200/1500 (Page 70) from the Program blocks.

Project_LUPS1600 » HMI_1 [TP900 Comfort] » HMItags » LUPS1600_TagTable$712001500RTAdv [3]

= EXIE
LUPS1600_TagTable$5712001500RTAdv
Name a Data type Connection PLCname | PLCtag Address Access mode
< alarmhistory Int <Internal tag> <Undefined>
- alarmpending | Int <nternal tag> <l d

40 » UPS_Data LUPS1600_typel... HM_Conne... [e] PLC_1 [UPs_clobal |§| l [+] <symbolic acces
<Add news

~ [ PLC_1 [CPU 1214C ...
v |5l Program blocks

- Name
[<] » @ LUPS1600_UPS._. =
" = » @ UPs_Global [... S u":;EGI = |
J Discrete alarms || Analog alarms || Logging tags b [iz] LUPS1600_FB L.......m......lf’

b LUPS1600_UPS1600_DB
D Name Alarm text A » i System blocks

» [;H Technology objects
» (g PLCtags

> T

Note
For 300/400 PLCs,
e For the "UPS_Data" tag, make sure:
— the "Connection” is set to "HMI_Connection_1".
— the global DB number in the "Address" column is set to 2.

Project_LUPS1600 » 400_HHI [TP900 Comfort] » Hil tags » LUPS1600_TagTableS7300400RTAdy [3]

FE2x
LUPS1600_TagTableS7300400RTAdv
Name a Data type Connection FLCnhame PLCtag Address Access mode Acquisition cycle Logg
ﬂr alarmhistory  Int <Internal tag> =Und.. 15 i
a alarmpending | Int <Internal tag= <Und 13
@ > UFsbara|Lupsi600_nypes7300400R.. [E] HMI_connecti.. [l Pies <u. [L][B2.08x0.0]<] <absolute access> 500 ms [=]
<Add neve
Operand identifier:  Ja5
08 e
Operand type: | DBEX >

S —
e —

[] x|
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5. Select the "UPS_Data" tag and go to "Properties > Properties > Settings" and make sure:
— the "Acquisition mode" is set to "Cyclic continuous".

— the "Acquisition cycle" value is set to "500 ms".

Project_LUPS1600 » HMI_1 [TP900 Comfort] » HMI tags » LUPS1600_TagTable$712001500RTAdv [3]

F BB
LUPS1600_TagTable5712001500RTAdv
— |Mame a Data type Connection PLC name |FLCtag | Address i
< alarmhistory Int <Internal tag> <Undefined>
< alarmpending  |Int <nternal tag> <Undefined=
|<@ » UPS_Data LUPS1600_typeU... || HM_Conne... | .. PLC_1 UPS_Global = [k
<Add new=
(<] il
™ =1
J Discrete alarms " Analog alarms || Logging tags
10 Llaroe Llarn eyt Llormn clace Loooerian Loooe ]
J Properties “ Events || Texts |
Settings
General =
- Settings
Settings
Range Acqguisition mode: |Cyc|ic continuous
Linear scaling Acquisition cycle: |500 ms
Values
Figure 8-26

6. In the "Project tree”, open the screen with the inserted faceplate (Screen_1).
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7. Select the faceplate on the screen in the display area and go to "Properties > Interface >
Data".

8. Select the "UPS1600Data_S71200/1500" property and connect the "UPS_Data" tag in
"LUPS1600_TagTableS712001500RTAdV" under the "Dynamization” column.

‘ Properties ] Interface j Animations ] Events H Texts
2B E
MName Static value Dynamization
* Data
AlarmviewB uffer 4 slarmhistory
AlarmviewPending ™~ alarmpendin

UPS1600Data_S71200.. .UPS_Bé(a 2. |
» Trends

» L PLC_1 [CPU 4163 FNIDF] |V
b LR PLC 2 [CPU 1214C DO,
w (|7} 1200_HM [TP900 Comfort] b

v g HMI tags i

Name Data type
Nene

|am | UPS_Data LUPS1600_typeUPSis...|

» 52 Defaulttag table [1]

N P UFs1600_TagTabl.

b 40 UPS_Data
<[ w | 2[<] I N E2
["] Show all |5 Edit | pganew | [ [X]

Figure 8-27

Connecting trends of the faceplate with data sources

The following procedure describes how to connect the trends of the faceplate with data
sources:

1. Inthe "Project tree", open the screen with the inserted faceplate (Screen_1)
2. Select the faceplate and go to "Properties > Interface > Trends".

3. Select "Trends" and click on the marked area in the "Static value" column to open the
settings for the trends of the UPS1600 module.

| Properties " Interface ” Animations ” Events ” Texts
B E
Name | Static value | Dynamization
» Data
¥ Trends
Trends Py 9o, |i‘
Figure 8-28

The "Trend" window opens.
4. In the "Trend" window, add five trends in the "Name" column.
5. Set the "Trend value" to 600 to all the five trends.

6. In the "Source settings" column, click the drop-down. "Data source" dialog box opens.
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7. For the "Process values" click on the highlighted area to navigate to the HMI tags and assign
the following tags to each of the trends:

inputVolt

outputVolt

outputCur

batteryVolt

measuredChargeCur

Properties Interface HAnimations ||Events ||Texts |

6| Properties

[%idinfo &[ %l Diagnostics ||

HA= =

Name || Istaticvalue |D

)

» Trends PN W [Trend_1

‘ Name l Style )Trend Mo )Trend type Source settirﬂs_lside lLimiws
] Trend_1 7 =100 Cyclical re__. [ inputvolt] [+ JLefe LR
<Add new>
Data source
Process values: |UPS_Data.inputVolt
Cyclic:
 arcus 0| —]
<] ] » [ Local modules
[ PLC_3 [CPU 416-3 PNIDF] [ Nome . - |pota...
» [l Program blacks <@ deV!CESWREV!". Byte
» [ Technology objects @ lEvice ey = ot
» [@ PLCtags 4@  endOfCharge... Real
» [ Local modules q Enput{ur cal
~ [ HMI_1 [TP200 Comfort] ﬂ Real |=
5 L-a H_M ens =<a loadCur Real
» ¢ Default tag table [1] a ma)()utCurh fye
~ 55 LUPS1600_TagTableS7300400R .. (i S neacUiEdChT e
< < outputCur Real
i" a urs_n,mi : o |b
< i > < il
G, Edit & Add new v
Figure 8-29
8. Set the "Cyclic" value to 0.5.
| Name [Style lTrend Voo lTrend type Source settings | Side l z
] Trend_1 N\ E 600 [£] cyclical re... F: [inputVolt] |=| Right E Ao
] Trend_2 N 600 Cyclical real ti...
= . - Data source
] Trend_s 600 Cyclical real ti...
@ Trend_4 N 600 Cyclical real ti.. Process values: | UPS_Data.inputVolt | = f1
] Trend_s N 600 Cyclical real ti... |Cyl;lic: BB 8l s
Sl
<| i
x
Figure 8-30
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108

9. In the "Style" column, select the trend color for the individual trends according to the legend

given below.

. UPS Input voltage

. UPS Output voltage

. UPS Output current
Battery voltage

. Battery charge current
Figure 8-31

10.In the "Side" column, select the value as "Right" to voltage tags and select the value as "Left"
to current tags assigned for the trends in step 6.

Name Style Trend v...  Trend type Source settings | Side Li...
ﬁ: Trend_1 / 600 Cyclical real ti... [inputvolt] Right ﬂﬂzi
| Trend_2 /\/ 600 Cyclical real ti... [chargeCur] Left ﬁ;’:
| Trend_3 600 Cyclical real ti... [batteniVolt] Right A
Li Trend_4 /\/ 600 Cyclical real ti... [outputCur] Left ﬁ:
| Trend_s NS 600 Cyclical real ti... [outputvolt] Right A b

e o]
<] i N

Figure 8-32
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Activating the alarms display

1. Inthe "Project tree", double click on "Runtime settings" and select "Alarms".

4 Project LUPS1600 »

Devices

= ‘ 'j" General
Services

¥ | ] Project_LUPS1600 (A Screens
] Keyboard

ﬁ Add new device
Eg't\ e T Good Manufacturin...

» [ PLC_1 [CPU 1214C DC/DCIRIY] -
» (i3 PLC_2 [CPU 315-2 PN/DP] User administration
» @ PLC_3 [CPU 416-3 PN/DP]
= [ HMI_1 [TP200 Comfort]
I]'f Device configuration

Language & font
OPC settings

Tag settings

%| Online & diagnostics

|¥ Runtime settings|
4 rfj Screens

Figure 8-33
2. Check the options "S7 diagnostic alarms" and "With event text".

Alarms

General

:

Buffer clearance in percent upon buffer overflow: |10
Acknowledgment group text: | QGR
Report:
Alarm class colors:

Download 57 diaghostics help texts:

System events

Display duration in seconds:

57 diagnostic alarms: With event text: [ |

3@3 LUNEINY)

SIMOTION diagnostic alarms:

Figure 8-34

Note

When configuring an S7-300/400 controller in TIA Portal, you also need to activate the S7
diagnostic alarm on the controller side.

Information on the display and configuration of diagnostic messages in WinCC TIA Portal is
available under the entry ID 62121503
(https:/Isupport.industry.siemens.com/cs/ww/en/view/62121503), see Chapter 3.2.2
‘Configuring CPU system diagnostic alarms', description 'Settings in STEP 7 Professional'.
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Configuring the alarms display

1. In the "Libraries" window, select "Global libraries > LUPS1600 > Master copies > LUPS1600 >
WinCC > Comfort/Advanced > AlarmWindows > LUPS1600_AlarmWindowsRTAdV".

Libraries

w0 p

Options

& Libranyview 2]

?> Project library

syse kit

~  Global libraries

b L] Buttons-and-Switches
» Ll Long Functions
» LLI Monitoring-and-control-objects
» LL] Documentation templates
|| LUPS1600
v [S Types
= [ Master copies
~ [ LUPS1600
» [tz STEP7
w [ WinCC
* [i:| Comfortiadvanced
v L] Alarmiindows

Fdhumx B E

saueiqr] E"

|~ LUPS1600_alarmwindowsRTAdy |

» [i:| TagTablesRTAdw
» [tz Professional
» :i Commaon data
P Languages & resources

. In the "Project tree", select "Screen management" and open "Global screen”.

Project tree o 4
Devices

Rk
=il

)

¥ | 7] Project_LUPS1600
B Add new device
g Devices & networks
» (18 PLC_1 [CPU 1214C DC/DCIRNy]
» (1§ PLC_2 [CPU 315-2 PN/DP]
» [ PLC_3 [CPU 416-3 PN/DP]
~ [ HMI_1 [TP300 Comfort]
ﬂf Device configuration
'] Online & diagnostics
1 Runtime settings
» _r|f| Screens
v [ screen management
» [[F Templates
» E Pop-up screens
» | slide-in screens
| =" Global screen|
] Permanent area

[>]

Figure 8-35
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3. Drag-and-drop "LUPS1600_AlarmWindowsRTAdV" into the global screen.

Libraries

LI 2

Options

Figure 8-36

| Libraryview (£

=

> :Project library

xuq|ool@[

+ : Global libraries

i G IR Tl
» LUl Buttons-and-Switches
» LUl Long Functions
» LI Monitoring-and-control-objects
» L] Documentation templates
« [ ] LUPS1600
» [5) Types
¥ [ | Master copies
w %] LUPS1600
» [tz STEF7
¥ |tz WinCC

=

suopewuy B,

node 1 ;igm

R

* it ComfortfAdvanced
\' = Alarmwindows
S [ Lups1e00_AlermwindowsRTAdv |

> ‘£z TagTablesRTAdw
» iz Professional
» [} Cornmon data
» | Languages & resources
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Configuring the alarms display call

1. Inthe "Project tree", under the "HMI tags" folder open
"LUPS1600_TagTableS712001500RTAdV".

Devices

ity

=

~ [ ] Project_LUPS1600 |~
I’ Add new device il
ﬁ%ﬂ Devices & networks
» [ PLC_1 [CPU 1214C DC/DC/RKy]
» [ PLC_2 [CPU 315-2 PN/DP]
» [ PLC_3 [CPU 416-3 PN/DP]
¥ [ HMI_1 [TP900 Comfort]
[h' Device configuration
%] online & diagnostics
Y Runtime settings
] ri screens
] r_ﬁ] Screen management
~ [ HM tags
% showall tags
I’ Add newtag table
é Default tag table [1]
Lﬂzl! LUPS1600_TagTableS712001..}
DZ. Connections

2. For the tags "alarmhistory" and "alarmpending", check if the assigned "Data type" is "Int" and
the "Connection" is "Internal tag".

LUPS1600_TagTable5712001500RTAdv

| MName a Data type ‘7C9nnection PLC name | FLCtag

<0 alarmhistory Int <nternal tag> <Undefined>

<40 alarmpending | Int <nternal tag> <Undefined=

4 » UPS_Data LUPS1600_typeUPS1600... [=]] HMI_Conne... [l PLC_1 UPS_Global =]
Figure 8-37
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3. Select the "alarmpending” tag and go to "Properties > Events > Value change". Check the

properties of the tag where in the "ShowAlarmWindow" function is inserted and its variable
"Object name" is assigned to the tag "Alarmview_UPS_Pending".

|§Properties || Info _J||JD|agnost|cs |
Properties Events [| Texts |
lTtT BE X

fi3] value change

On exceeding

¥ ShowAlarmWindow

On falling below Object name Alarmview_UPS_Pending

Display mode Toggle

<Add function=

Figure 8-38

Similarly, check the properties of the tag "alarmhistory" where in the "ShowAlarmWindow"
function is inserted and its variable "Object name" is assigned to the tag
"Alarmview_UPS_History".

4. Open the screen (Screen_1) and select the faceplate. Go to "Properties > Interface > Data".

5. Assign the "alarmhistory" tag to "AlarmviewBuffer" element.

S sio o oo

10:57:59 AM
12/31/2000

» L FLC_1 [CPU 41 6-3 FNIDF]
» [ PLC_2 [CPU1214C DCID...
w [ 400_HMI [TP900 Comfart]

BN b v [ HMI tags —
» =55 Defaulttag table [1 =
? - 0l e | alarmpending  Int
|3 LUPS1600_TagTable..| |

» 0 UP5_Data

Properties Interface ” Animations I Eve

—_—
A==
Name
¥ Data

AlarmviewBuffer

Alarmyviewfending

Figure 8-39

<] ]
[} show all |q Edit

| B Add new % [:].

Staticvalue

4 [

M

.

6. Assign the "alarmpending” tag to "AlarmviewPending" element.

Note

When using an S7-300 or S7-1200 CPU, no alarms are displayed on the HMI faceplate. Hence
no messages are displayed in the "Alarm history" and "Alarm pending" window.
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Displaying the PROFINET diagnostic messages

114

To display the PROFINET diagnostic messages of the SITOP UPS1600 within the faceplate, the
respective WinCC TIA Portal project must already be configured.

Information on the display and configuration of diagnostic messages in WinCC TIA Portal is
available under the entry ID 62121503
(https:/Isupport.industry.siemens.com/cs/ww/en/view/62121503).

Activation of the PROFINET diagnostic messages of the UPS1600 is found in the "Device view"
of the UPS1600.

...Jistributed FO » PROFINET IO-System (100): PN/IE_1 » DC-UPS-20A_1 - i EX

|§ Topology view "ﬁﬂ-h Network view ||ﬂ‘f Device view |_

#¢ [ocurs204 [+ &“‘@ o @ s - =
K

gl alal|s|a =]

Rack_0

| v | | =y

¥] —§— ®H

|§Pmperties ||"_i.'.|nfo i,l"i-JDiagnnstics I

[<u]

J General " 10 tags " System constants " Texts |

b General

P PROFINET interface ...

» Device configuration

¥ IQ data [V Hardware interrupt:
General

Inputs

Fy

| ts: i i
Ewvent name: IHardware interrupt I
O addresses

Hardware identifier Hardware interrupt: I_ -—]

T il

b Web server Priority |16 I

Figure 8-40

Further notes regarding the PROFINET diagnostic messages of the SITOP UPS1600 is available
in the chapter 4 of the SITOP UPS1600 User Manual
(https:/Isupport.industry.siemens.com/cs/ww/en/view/84977415).
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8.4 Application of screen windows in WinCC Professional V16
8.4.1 Prerequisites
Requirements

The following requirements must be met to use the screen windows in WinCC Professional
V16:

e The HSP for the SITOP UPS1600 is installed in STEP 7 V16.

e S7 communication between the SITOP UPS1600 and SIMATIC S7 controller is already
configured.

e All program blocks for STEP 7 V16 from LUPS1600 are integrated into the application
program and executable.

e LUPS1600 is available on your computer.

Supported control panels

The screen windows are supported for the following control panels:
e WinCCRT Professional V16

Supported languages
The screen windows support the following languages:
e English (USA)
e German (Germany)

e Chinese (PR China)
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8.4.2

Library for WinCC Professional

Library for WinCC Professional

8.4.3

Overview

The following objects are part of the master copy "UPS1600 TIA Library > UPS1600 Wincc >
Screens > Professional > ScreensRTProf" in LUPS1600:

Table 8- 3

Name

Type

Description

LUPS1600_ScrnWndwRTProf

Screen window

Comprises the screen window

LUPS1600_ScrnRTProf

Screen

Comprises the screen 'LUPS1600_ScrnRTProf'

Integrating the screen windows

The following sections describe all the steps required to integrate the screen windows into a
WinCC Professional V16 project:

Target system used:

e  WinCC RT Professional V16

Opening the library in WinCC V16

116

The procedure for opening the library in WinCC Professional V16 is explained in the Content
of the library for STEP 7 V16 (Page 55).
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Inserting HMI tag table in WinCC
The following procedure describes how to insert HMI tag table into the WinCC project:

1. Inthe "Libraries" window, select "Global libraries > LUPS1600 > Master copies > LUPS1600 >
WinCC > Professional > TagTablesRTProf > LUPS1600_TagTableS712001500RTProf".

Libraries

Options
#] Libraryview £ 0
? Project library

~ i Global libraries

FR LU W ]
» Ll Buttons-and-Switches

» LIl Long Functions

» [l Monitaring-and-contral-abjects

saueiqr £ " syse | il

» LIl Documentation templates
* [ L] LUPS1600
» 3] Types
~ [ Master copies
= [t LUPS1600
» [t STEF7
[t Winco
b [i:| Comfortiadvanced
w %] Professional
» [t:| ScreensRTProf
w [i:] TagTablesRTProf

g LUPS1600_TagTable57300400RTProf

= LLIPS'I 600_TagTableS712001 5EIIJFI.TPrrJ.

» [} common data

¥ Languages &resources
Figure 8-41
Note

$7-300/400 PLCs
For S7-300/400 PLCs, select "LUPS1600_TagTableS7300400RTProf".
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2. Drag-and-drop "LUPS1600_TagTableS712001500RTProf" into the "HMI tags" folder in the
"Project tree".

Project tree o 4
Devices
~ | ] Project_LUPS1600 |~

I’ Add new device
n%h Devices & networks
» [ PLC_1 [CPU 1214C DC/DC/RK]
» [ PLC_2 [CPU 315-2 PN/DP]
» [ PLC_3 [CPU 416-3 PN/DP]
» =i HMI_1 [TP900 Comfort]
~ [ PcSystem_1 [SIMATIC PC station]
: [IY pevice configuration
: %] Online & diagnostics
= v [ HMI_RT_1 [WinCC RT Professio...
: [I‘f Device configuration
{ Runtime settings
» E Screens
4 rﬂ_] Screen management

|P:E HMI tags I

¥2a Connections

Figure 8-42
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Configuring connections of HMI tag table
The following procedure describes how to configure connections of HMI tag table:

1. Inthe "Project tree", select "HMI tags > LUPS1600_TagTableS712001500RTProf" and open
the tag table.

Devices

“np

~ | ] Project_LUPS1600

B Add new device

g Devices & networks
» [ PLC_1 [CPU 1214C DC/DCIRNy]
» [ PLC_2 [CPU 315-2 PN/DP]
» [ PLC_3 [CPU 416-3 PN/DP]
» |5 HMI_1 [TP900 Comfort]
~ [0 PCSystem_1 [SIMATIC PC station]
: [IY pevice configuration

') online & diagnostics

= v [ HMI_RT_1 [WinCC RT Professio_..
: I]'f Device configuration

2]

{1 Runtime settings
» 'E] Screens
4 r_ﬁ] Screen management
= ‘:a HMI tags
%5 showall tags
ﬁ Add new tag table
55 Default tag table [27]
|55 LUPS1600_TagTables712...
%24 Connections

Figure 8-43

2. For the "UPS_Data" tag, set the global DB (UPS_Global) created in Procedure when using an
S7-1200/1500 (Page 70) from the Program blocks.

LUPS1600_TagTable5712001500RTProf

Name a  Data type Connection PLC name vFLCtag | Address | Accessmode | Logged | Synchronizi
<0 » UPS_Data LUPS1600_typeU... @ HMI_Conne... E PLC_1 B B <symbolic access>
<Add new=
~@ncticuizucoc. | 8l [ |
gl Program blocks —
= Name
(<] » @ LUPS1600_UPS160... |= -
None
. . » @ UPS_Global [DB1]
Discrete alarms || Analog alarms “ Logging tags = I
» [Z:] LUPS1600_FB L
D Name Alarm text Alg » |3 System blocks P
<Add news » [3 Technology objects
» [g PLCtags
[ w ]
[showall vix]
=
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8.4 Application of screen windows in WinCC Professional V16

Note
For 300/400 PLCs,
e For the "UPS_Data" tag, make sure:
— the "Connection” is set to "HMI_Connection_1".
— the global DB number in the "Address" column is set to 2.

LUPS1600_TagTableS7300400RTProf

Name a Data type ~ Connection PLCname | PLCtag _|Address Access mode Logged | Synchrc
4@ » UPS_Data  LUPS1600_types7...[E]| HM_Conne... [ PLC 2 <Undefined> [ll[ %DB2.0BX0.0 | 'i]Ghsclute sccess>
<Add news

operand deriier: TN -

l<ﬂ IDB number: [21 |

Operand ope:

discrete alarms “ Analog alarms II Logging tags addse: l:‘
D Name Alarm text |Alarm class

genumber 0|

E-ix|

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7

120 Function Manual, 11.2021, A5E39439812-05-76



Application of the faceplates

8.4 Application of screen windows in WinCC Professional V16

Inserting screen windows into a project

The following procedure describes how to integrate a screen from the library into an existing

WinCC project:

1. Open the project in "Project view".

2. In the "Libraries" window, select "Global libraries > LUPS1600 > Master copies > LUPS1600 >
WinCC > Professional > ScreensRTProf > LUPS1600_ScrnRTProf".

Libraries w0 p

Options

| Library view £

syse it

> Project library

+ i Global libraries

.]
lh
L

¥ Ll Buttons-and-Switches
» LUl Lang Functions
» LLI Monitoring-and-control-abjects
» Ll Documentation templates
« [ | LUPS1600
» 5 Types
~ [ Master copies
= |5 LUPS1600
» |i:) STEP7
w Lo WincC
» iz Comfortiadvanced

- Professional

[a
E2|
-

|£z| ScreensRTProf

Fd Lo B =

saueiqr] E"

|

| LUPS1600_ScrnRTFrof |

LUPS1600_ScrmwndwRTFrof
» [t:| TagTablesRTProf
» L} common data
¥ Languages & resources

Figure 8-44
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8.4 Application of screen windows in WinCC Professional V16

122

3.

In the "Project tree", open the "Screens" folder of the HMI used in the project.

4. Drag-and-drop "LUPS1600_ScrnRTProf" into the "Screens" folder.

Project tree

Devices

m 4

~ | ] Project_LUPS1600
E Add new device
Eg-h Devices & networks
» [ PLC_1 [CPU 1274C DC/DCRIY]
» [ PLC_2 [CPU 315-2 PN/DF]
» [ PLC_3 [CPU 416-3 PN/DF]
» [53 400_HMI [TP200 Comfart]
» [0 1200_HMI [TP200 Comfort]
» (D 400_PC-Systern_1 [SIMATIC PC statian]
b [ﬁ 1200_PC-Systern_2 [SIMATIC PC station]
: [IY pevice configuration
%) online & diagnostics
= v [ HMI_RT_2 [WinCC RT Professional]
: [l'f Device configuration
1 Runtime settings
* [_E] Screens
B Add new screen

|[T] LUPS1600_ScrnRTProf |

[>]

F| Screen_1

.=

SITOP UPS1600 Firmware V2.4: Faceplates and Communication Blocks V3.1 for SIMATIC STEP7

Function Manual, 11.2021, A5E39439812-05-76



Application of the faceplates
8.4 Application of screen windows in WinCC Professional V16

Integrating screen windows into a project
The following procedure describes how to integrate the screen window from the library into
an existing WinCC project:

1. Inthe "Project tree", open the screen into which you want to insert the screen windows

(Screen_1).

Project tree m 4
Devices

¥ | ] Project_LUPS1600 ~]

E Add new device
Egh Devices & networks
» [ PLC_1 [CPU 1214C DC/DCRIY]
» [ PLC_2 [CPU 315-2 PN/DP]
» [ PLC_3[CPU 416-3 PN/DP]
v [=3 400_HMI [TP00 Comfort]
» [0 1200_HMI [TP200 Comfart]
» (D 400_PC-System_1 [SIMATIC PC station]
b [ﬁ 1200_PC-Systern_2 [SIMATIC PC station]
: ¥ pevice configuration
: %] online & diagnostics
= v [ HMI_RT_2 [WinCC RT Prafessional]
: [l'f Device configuration

1 Runtime settings
* _rrj Screens
B Add new screen
[] LUPS1600_ScrnRTProf

|E| Screen_1|
r—

2. Inthe "Libraries" window, select "Global libraries > LUPS1600 > Master copies > LUPS1600 >
WinCC > Professional > ScreensRTProf > LUPS1600_ScrnWndwRTProf".
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8.4 Application of screen windows in WinCC Professional

Vié

3. Drag-and-drop "LUPS1600_ScrnWndwRTProf" to the screen.

Libraries w0 p

Options

#| Library view £

b

Project library

X0¢]|00 | J;)|

b

Global libraries

0%

\ i

CR

MName

» LL| Buttons-and-Switches
» Ll Long Functions
» L1l Monitoring-and-control-objects
» LL| Documentation templates
|| LUPS1600

» 5] Types

w [ Master copies
LUPS 1600
STEF7
WinCC

v &l
b sl
v e
¥ |tz Professional

'tz| ScreensRTProf
__| LUPS1600_ScrnRTProf

suoleLIuY 'a,l

nodeT

suoIPNIIsU| [:'-I%”

o~ [ LuPS1600_Scrnwindw

RTProf |

Figure 8-45

Assign "Tag prefix" variable with th

» iz TagTablesRTProf
» [L§ common data

» | Languages & resources

Select the screen window and go to "Properties > Properties > General".

e "UPS_Data" tag present in

"LUPS1600_TagTableS712001500RTProf" folder.

|g Properties |'3.'. Inf

o y"ﬂ Diagnostics

J Properties I Animations " Events " Texts |
33’ Property list General
Contents Indepel
Appearance
Layout L Title: |UPS1600 | In
Wl L Displayed screen: |UPS16C|D [_EH] A
’: Configurations: | |_§”l e

Figure 8-46

Zoom factor: | 100 :l %

| Tag prefix |UPS_Data I

Process tag |
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8.4 Application of screen windows in WinCC Professional V16

Displaying the PROFINET diagnostic messages

To display the PROFINET diagnostic messages of the UPS1600 within the screen windows, the
respective WinCC TIA Portal project must already be configured.

Information on the display and configuration of diagnostic messages in WinCC TIA Portal is
available under the entry ID: 62121503
(https:/Isupport.industry.siemens.com/cs/wwl/en/view/62121503).

The activation of the PROFINET diagnostic messages of the UPS1600 is found in the "Device
view" of the UPS1600.

..Jistributed FO » PROFINET IO-System (100): PN/IE_1 » DC-UPS-20A_1 - EX

|§ Topology view "ﬁﬂ-h Network view ||ﬂ‘f Device view \_

d¢ [DcUPs-204 1 F];.l &m H @ =
El
1 2 3 4 5 & =
Rack_0
.
v
9t |59
[< ][] [> | [100% o — v &
|§Pmpenies ||"_i.'.|nfo y"i-] Diagnostics I
J General || 10 tags || System constants || Texts |
P General o

» PROFINET interface ...
» Device configuration

/O data [\ Hardware interrupt:
General
Inputs n :
N Event name: IHardware Interrupt I

O addresses

Hardware interrupt: I — w,]

vl

Hardware identifier

P ieb server Priotity |16

Figure 8-47
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8.4 Application of screen windows in WinCC Professional V16

Note

* When configuring an S7-300/400 controller in TIA Portal, you also need to activate the S7
diagnostic alarm on the controller side.

* Information on the display and configuration of diagnostic messages in WinCC TIA Portal is
available under the entry ID 62121503, see Chapter 3.2.2 'Configuring CPU system
diagnostic alarms', description 'Settings in STEP 7 Professional'.

* There can be differences regarding the S7-1200 diagnosis with respect to the S7-1500.

Further notes regarding the PROFINET diagnostic messages of the SITOP UPS1600 are
available in the chapter 4 of the SITOP UPS1600 User Manual
(https:/Isupport.industry.siemens.com/cs/ww/en/view/84977415).
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